Contents

Get Started with Your Account ................................................................. 1
  Log In ................................................................. 1
  Download GoToWebinar ................................................................. 2
  Automatic Upgrades (Windows only) .............................................. 3
  System Requirements ........................................................................ 4
  Forgot Your Password ......................................................................... 6
  Can’t Access Your Account .............................................................. 6
  Change Your Email Address and Password ........................................ 7
  Edit Your Personal Info ........................................................................ 8
  Update Your Billing Info ....................................................................... 9
  Set Your Default Language ............................................................... 10
  Preferences for Windows Users ........................................................ 11
  Preferences for Mac Users ..................................................................... 17
  Change Your Plan ................................................................................ 18
  Cancel Your Account ........................................................................... 19
  What's New? ..................................................................................... 23

Start, Schedule and Manage Webinars ................................................. 25
  Schedule a Webinar ........................................................................... 25
  Customize Your Webinar ................................................................. 27
  Set Default Audio Options ................................................................. 31
  Integrated Toll-Free Audio Service .................................................... 34
  Share Webinars, Manage Registration and Send Emails .................. 35
    Add additional registration fields .................................................... 37
    Create, edit, sort or delete custom registration questions ................. 38
    Automatically or manually approve registrants .............................. 39
    Direct registrants to a confirmation page ....................................... 39
    Approve, deny or cancel registration ............................................. 40
    Send confirmation emails to registrants ........................................ 41
    Send reminder emails to registrants and panelists ....................... 42
    Send follow-up emails to attendees and absentees ...................... 43
  Engage Attendees with Polls and Surveys .......................................... 45
  Schedule Similar Webinars .............................................................. 48
# Table of Contents

Upcoming Webinars ................................................................. 50
Past Webinars ........................................................................ 50
Practice a Webinar ............................................................... 51
Start a Scheduled Webinar .................................................. 52
Upload, Share and Delete a Recording ................................... 54
Cancel Webinar ...................................................................... 57

Mobile Devices ........................................................................ 58
- GoToMeeting App for iOS .................................................... 58
- GoToMeeting App for Android ............................................ 65
- GoToMeeting App for iOS Session Features ...................... 70
- Mobile Feature Comparison ................................................ 72

Join Sessions ......................................................................... 74
- Register for a Session ........................................................ 74
- Join a Session .................................................................. 75

Session Features ................................................................. 78
- Control Panel and Grab Tab ............................................... 78
- Invite Others ................................................................... 79
- Test Connection with GoToWebinar ................................. 80
- Audio ............................................................................. 81
- Co-Organizers ................................................................ 89
- Screen Sharing ............................................................... 93
- HDFaces Video Conferencing .......................................... 94
- Recording ........................................................................ 99
- GoToMeeting Recording Manager (Mac) ......................... 101
- Give Keyboard and Mouse Control ............................... 103
- Change Presenter .......................................................... 105
- Drawing Tools .............................................................. 106
- Dashboard ...................................................................... 107
- Audience View ............................................................ 108
- Attendee List ................................................................. 109
- Polls ............................................................................. 109
- Question and Answer ..................................................... 111
- Labs Menu ..................................................................... 112
- Chat ............................................................................ 116
Desktop Notifications (Windows) ................................................................. 117
Leave and End a Session ................................................................. 118

Reports and History .............................................................................. 119
Registration Report ............................................................................. 119
Attendee Report ................................................................................. 121
Performance Report ............................................................................ 123
Survey Report ...................................................................................... 125
Recorded Webinar Report ................................................................. 127
View Webinar History ......................................................................... 129

FAQs ........................................................................................................ 130
Join a Session ....................................................................................... 130
Audio Conferencing FAQs .................................................................. 131
Integrated Toll-Free Audio FAQs ....................................................... 133
Multi-Seat Admin FAQs ..................................................................... 134
Host a Webinar FAQs ......................................................................... 135
GoToWebinar Roles ............................................................................ 136
In-Session FAQs ................................................................................. 137
HDFaces Video Conferencing FAQs .................................................. 137
GoToWebinar Features FAQs .............................................................. 140
Recording and Playback FAQs ........................................................... 141
Billing and Cancellation FAQs ............................................................ 144
Security FAQs ..................................................................................... 146
GoToMeeting App for Android FAQs .................................................. 146
GoToMeeting App for iPad, iPhone and iPod Touch ......................... 150

Troubleshooting .................................................................................. 155
Audio Help ........................................................................................... 155
Broadcast Computer Audio ............................................................... 157
Disable the Launcher Plugin ............................................................... 158
Download the Launcher File on Mac .................................................. 162
Download the Launcher File on Windows .......................................... 169
Join Help .............................................................................................. 177
Test Your Connection before Your Session ....................................... 185
Get Started with Your Account

Log In

Log in to your account

After you've created your GoToWebinar account, use the email address and password you signed up with to log in to access all of GoToWebinar easy-to-use features!

- Schedule and host webinars
- Upload webinar recordings
- View webinar history
- Create reports
- Set default audio options

Forgot your password?

1. Go to the Forgot Your Password? page.
2. Enter the email address you use to log in to your account.
3. Click Continue to reset your password.
4. Once you receive the Forgot Your Password email, click the link to create a new password. Then log in using your newly created password.
Don't have an account?

Try GoToWebinar free for 30 days! Included in your 30-day free trial:

- Unlimited online sessions
- Up to 1000 attendees per session
- Audio via telephone and/or mic and speakers
- Free product training and 24/7 support

Download GoToWebinar

To start a session, the GoToWebinar desktop application must first be installed onto your computer. When you start or join a session, GoToWebinar automatically begins downloading.

Download the GoToWebinar software

- [Start GoToWebinar](#)
- [Join Webinar](#)

Download the GoToMeeting mobile apps

- [Download the GoToMeeting App for Android](#)
- [Download the GoToMeeting App for iOS](#)

Having trouble downloading GoToWebinar?

Learn more about downloading the installer for the first time on [Windows](#) and [Mac](#).

Can't join a session?

If you're running into problems joining a session, see [Join Help](#).
Automatic Upgrades (Windows only)

You can easily install the latest version of GoToWebinar whenever an update is available using the automatic updates feature. You won’t be prompted to install the latest version – you’ll simply get upgraded seamlessly when you’re not in session. By default on Windows, the automatic updates feature is enabled if you’re logged in to the application and have the “Remember me on this computer” option selected.

Enable or disable automatic updates

Note: If you prefer to be prompted every 24 hours the next time an update is available, you may turn off automatic updates, but you’ll be required to go through the download process.

1. Right-click the GoToMeeting daisy icon in your system tray and select Preferences.

2. The default setting is to automatically install updates. If you wish to disable automatic updates, uncheck the “Automatically install updates” check box.

You can click learn about our latest updates to see what’s new in the latest version.
System Requirements

Please check to see that you meet the minimum system requirements and that you have the equipment you need before downloading the latest version of GoToWebinar.

What are the system requirements for running GoToWebinar?

<table>
<thead>
<tr>
<th>Windows</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 8</td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
</tr>
<tr>
<td></td>
<td>Windows XP</td>
</tr>
<tr>
<td></td>
<td>Windows 2003 Server</td>
</tr>
<tr>
<td>Processor</td>
<td>2.4GHz or more</td>
</tr>
<tr>
<td>RAM</td>
<td>2GB or more</td>
</tr>
<tr>
<td>Internet</td>
<td>DSL or better</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>700Kbps or more for simultaneous screen sharing, video and audio conferencing</td>
</tr>
<tr>
<td>Browser</td>
<td>Internet Explorer® 7.0 or newer</td>
</tr>
<tr>
<td></td>
<td>Mozilla® Firefox® 4.0 or newer</td>
</tr>
<tr>
<td></td>
<td>Google Chrome™ 5.0 or newer</td>
</tr>
<tr>
<td>Additional software</td>
<td>JavaScript™</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mac</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Mac OS® X 10.6 (Snow Leopard®)</td>
</tr>
<tr>
<td></td>
<td>Mac OS® X 10.7 (Lion®)</td>
</tr>
<tr>
<td></td>
<td>Mac OS® X 10.8 (Mountain Lion®)</td>
</tr>
<tr>
<td>Processor</td>
<td>2.4GHz Intel processor (Core 2 Duo)</td>
</tr>
<tr>
<td>RAM</td>
<td>1GB</td>
</tr>
<tr>
<td>Internet</td>
<td>DSL or better</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>700Kbps or more for simultaneous screen sharing, video and audio conferencing</td>
</tr>
<tr>
<td>Browser</td>
<td>Safari® 3.0 or newer</td>
</tr>
<tr>
<td></td>
<td>Mozilla® Firefox® 4.0 or newer</td>
</tr>
<tr>
<td></td>
<td>Google Chrome™ 5.0 or newer</td>
</tr>
<tr>
<td>Additional software</td>
<td>JavaScript™</td>
</tr>
</tbody>
</table>
What equipment do I need to use GoToWebinar?

All you need to start using GoToWebinar are the following:

- Windows or Mac computer
- Internet connection (broadband is best)
- Microphone and speakers (built-in or USB headset)
- Webcam to use HDFaces video conferencing

Most computers have built-in microphones and speakers, but you will get much better audio quality if you use a headset or handset. You can also make calls on your landline or mobile device.
Forgot Your Password

If you can't remember your password, you can reset it with a few easy steps!

Forgot your password?

1. Go to the Forgot Your Password? page.
2. Enter the email address you use to log in to your account.
3. Click Continue to reset your password.
4. Once you receive the Forgot Your Password email, click the link to create a new password. Then log in using your newly created password.

If you're still having trouble accessing your account, contact Global Customer Support.

Can't Access Your Account

If you're trying to log in but can't access your account, your subscription may have expired. You'll need to first update your billing information to continue using GoToWebinar.

Update your account

1. Log in to your GoToWebinar account.
2. You should be taken directly to the My Account page. In the Plan Details, click Subscribe Now to sign up for a paid subscription plan.
3. Choose the plan that best fits your needs, and click Review Your Plan.
4. On the Confirm Your Plan page, click Purchase Now. To ensure uninterrupted service, you will be billed automatically on the billing date. You can click Turn Off Renewal on the My Account page at any time to turn off automatic renewal.
5. Once you confirm your plan, you'll be able to use GoToWebinar without any disruptions.
Change Your Email Address and Password

You can change the email address and password you use to log in to your account.

Change your login info

1. Log in to your GoToWebinar account.
2. Select My Account in the top navigation.
3. On the My Account page, click Edit next to Login Info.
4. On the Change Login Information page, you can change your email address and/or password.
   - To change your email address, edit your email address in the Email Address field.
   - To change your password, enter your new password twice – it must contain 8 - 32 alphanumeric characters.
5. Then enter your current password. If you forgot your password, click Forgot password? Enter your email address and reset your password by opening the link you receive in the Forgot Password email.
6. When you’re done, click Save Changes. You’ll see a confirmation message saying that your login information has been updated.
Edit Your Personal Info

You can edit your personal info, such as your first and last name, primary language, time zone and daytime phone number.

Edit your personal info

1. Log in to your GoToWebinar account.
2. Select My Account in the top navigation.
3. On the My Account page, click Edit next to Personal Info.
4. On the Change Personal Information page, you can edit your first or last name, primary language, time zone and daytime phone number (optional). You can also add your Twitter username to post questions about GoToWebinar and receive support.
5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your personal information has been updated.
Update Your Billing Info

You can change or update your billing info at any time. If you have a corporate account, follow steps 1 - 2 below, and then click **Contact Us** in the Account Details section for Corporate Billing support.

Change your billing info

1. [Log in](#) to your GoToWebinar account.
2. Select **My Account** in the top navigation.
3. On the My Account page, click **Edit** next to Billing Info.
4. On the Change Billing Information page, you can change your credit card information.
5. When you're done, click **Save Changes**. You'll see a confirmation message saying that your billing information has been updated.

![Image of the Billing Information Form](image-url)
Set Your Default Language

You can set your default language for how you view the GoToWebinar website from the My Account page. After you’ve chosen your preferred primary language, you can view the GoToWebinar website in that language. You can also choose your preferred language while you’re in-session – whatever language your operating system is set to is the default language for your in-session experience, but you can change that at any time from your Windows computer.

Set your account’s default language

1. Log in to your GoToWebinar account.
2. Select My Account in the top navigation.
3. On the My Account page, click Edit next to Personal Info.
4. On the Change Personal Information page, you can choose your primary language so that the GoToWebinar website appears in your preferred language.
5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your personal information has been updated.

Choose your language in-session (Windows only)

1. During a session, select the Globe icon at the top of your Control Panel.
2. Select your preferred language. You can switch languages at any time by selecting another language from the Globe icon.
Preferences for Windows Users

The GoToMeeting Preferences feature allows you to set preferences for running GoToMeeting, choose which GoToMeeting integrations are displayed and test the GoToMeeting connection.

Windows users can access GoToMeeting Preferences by right-clicking the daisy icon in the system tray, or if in a meeting, from the File menu.

Mac users can access their GoToMeeting Preferences by double-clicking the GoToMeeting Suite icon on their desktop and selecting Preferences from the GoToMeeting menu in the menu bar. Please see Preferences - Mac Users for more information.

Start Up Preferences

The Start Up category lets you determine how you start GoToMeeting.

- **Automatically after I log in to Windows** - This option starts GoToMeeting automatically after you log in to your PC.
- **Manually** - This option sets GoToMeeting to start only when you launch the application from your Programs menu.
- **Remember me on this computer** - This checkbox enables automatic login to GoToMeeting.
- **Show me desktop notifications** - Desktop Notifications is a free GoToMeeting feature designed to deliver simple and effortless access to complimentary Citrix Online software upgrades, information, news and discounts individual users may be eligible for.
- **Remind me of upcoming meetings** - This check box becomes available if you select Remember me on this computer and provides reminders for your scheduled meetings.
- **Automatic Updates** - Upgrade seamlessly to the newest version of GoToMeeting without being prompted.
General Preferences

The General category lets you set your general GoToMeeting preferences.

- **File save settings** - Enables you to save the Chat Log to any drive or directory.
- **Security** - Set the inactivity timeout to automatically stop screen sharing if there is no keyboard input or mouse movement for the specified period of time.
- **Session Identity** - Remember your name and email as displayed in the attendee list.

Meetings Preferences

The Meetings category lets you determine which GoToMeeting options are available to attendees during a meeting. You can also select which messages are viewable during a meeting.

- Enable or disable the ability for attendees to chat and view the Attendee List.
- Create a Chat Welcome Message that is sent to each attendee upon joining the meeting.
- Enable or disable various system messages that appear to you when specific meeting actions occur.
- Select the desired color for your GoToMeeting Viewer and Control Panel.

**Note**: If you disable the Chat Bubbles option, a new message icon will still appear on the Grab Tab to notify you of new chat messages as they are received.
Recording Preferences

The Recording category lets you set your audio and video recording preferences. See Record a Meeting for more information.

- **Audio** - Allows you to enable or disable recording the audio portion of your meeting. To record, choose which audio service you have scheduled to use for your meeting (see the following table).
- **Video** - Allows you to select the meeting recording output format and destination for saving the file.

**Note:** Be sure to check your audio device settings under Audio in the left menu.

**Note:** Mac users can only view meetings recorded in the Windows Media Player format.

- **Save in** - Select the folder in which you want to save your recording.

<table>
<thead>
<tr>
<th>Using GoToMeeting Integrated Audio</th>
<th>Using Your Own Audio Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records all unmuted speakers in the meeting</td>
<td>To record all unmuted speakers, you will need a phone patch connected to both your phone and the mic in port of your computer.</td>
</tr>
<tr>
<td></td>
<td>To record just your voice, you will need a microphone connected to your computer.</td>
</tr>
<tr>
<td></td>
<td>If you want to use VoIP with your own audio service, please contact your Account Manager (GoToMeeting corporate plans) or Global Customer Support (GoToMeeting plans).</td>
</tr>
</tbody>
</table>

Your Windows must have a sound card installed in order to record audio. For example, if you can hear music through your Windows, you have a sound card.

Mac users are not able to record a meeting. If you want your meeting recorded, promote a Windows attendee to organizer in-session. A Windows-based organizer will have the recording feature.
Integration Preferences

The Integrations category lets you determine where to display GoToMeeting integrations. Options include:

- **Use GoToMeeting with** - Select your GoToMeeting email and calendar integration. By selecting My default email application you can integrate with MAPI-compliant email/calendar programs other than Microsoft Outlook and Lotus Notes. Depending on your email application’s capabilities, integration with MAPI-enabled programs allows for features such as automatically adding meetings to a calendar and automatic creation of email messages with meeting information.

- **Show GoToMeeting Toolbar in Microsoft Office** - Display the GoToMeeting Toolbar in Microsoft Word, Excel and PowerPoint.

**Note:** Changes will only be displayed after restarting Outlook, Lotus Notes and/or the instant-messaging application.

Connection Preferences

The Connection category allows you to test the status of your GoToMeeting connection.

**Note:** To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMeeting Global Customer Care representative directs you to perform the connection test.
Audio Preferences

The Audio category lets you set up and test your microphone and speakers for recording and for your meetings utilizing VoIP. If changes to your audio settings are made during a meeting, your microphone is temporarily muted so you can privately manage your settings. See GoToMeeting Integrated Audio for more information.

- **Microphone Setup** - Select a microphone from the drop-down menu. To test, speak into your microphone; if connected correctly, the sound bar will move when you speak.
- **Speakers Setup** - Select your speakers from the drop-down menu. To test, click **Play Sound**; if connected correctly, the sound bar will move and you will hear a short soundtrack.
- **Advanced** - GoToMeeting automatically adjusts system mixer settings. We recommend you keep this checked. If you uncheck this selection, you must manually configure your audio settings through Windows Sounds and Audio Devices.
- **Use automatic volume and noise processing** - This option usually improves audio quality when people are talking. Unchecking this box may improve quality of music or other audio sources.
Webcam Preferences

The Webcam category lets you set up and test your webcam for HDFaces Video Conferencing. Options include:

- **Your camera** - Shows the make and model of your detected webcam.
- **Select a display format** - Adjusts the aspect ratios of webcam feeds. (4:3 is the normal display and 16:9 is the widescreen display.
- **Advanced** - Modifies your hardware settings from within GoToMeeting. Customizable options depend on your webcam manufacturer.
Preferences for Mac Users

GoToMeeting Preferences allow you to set preferences for running GoToMeeting, choose where you want to store recordings, select what your attendees can see and set your webcam preferences.

Mac users may access the GoToMeeting preferences by double-clicking the GoToMeeting Suite icon on their desktop and selecting Preferences from the GoToMeeting menu in the menu bar.

General Preferences

The General tab allows you store your account information and display name for meetings. If you check the "Remember me on this computer," your account information will be saved and you will not need to re-enter it when you join a meeting. You can also select the "Use GoToMeeting with default email application" check box to add email integration to your GoToMeeting account.

Recording Preferences

The recordings tab allows you to choose where you would like to store your recordings and how you would like to be notified to convert your recordings (you must convert recordings before anyone can see them).

Meeting Preferences

The Meetings tab lets you determine which GoToMeeting options are available to attendees during a meeting. Options include:

- Enable or disable the ability for attendees to chat and view the Attendee List.
- Create a welcome message that is sent to each attendee upon joining the meeting

Webcam Preferences

The Webcam tab allows you to select a camera to use for your webcam as well as a display format.
Change Your Plan

You can change your plan at any time. Since your service is pre-paid, changes made to your plan won’t take effect until the end of your subscription period. If you have a corporate plan, you must contact your Account Manager or Global Customer Support.

Change your subscription plan

1. Log in to your GoToWebinar account.
2. Select My Account in the top navigation.
3. On the My Account page, click Change Plan in the Plan Details section.
4. On the Choose a Plan page, select a plan that best fits your needs. To purchase a multi-seat account, select the number of organizer seats you need from the drop-down menu.
5. On the Confirm Your Plan page, click Purchase Now. You can click Edit next to Plan Details or Billing Info to make any changes.

Your plan will renew on your billing start date to ensure uninterrupted service. Your credit card on file will be automatically charged. Learn about how to turn off automatic renewal.
Cancel Your Account

You can turn off automatic renewal for your plan at any time. Since your service is pre-paid, changes made to your plan won't take effect until the end of your subscription period. To immediately cancel your plan, contact Global Customer Support for assistance. If you have a corporate plan, you must contact your Account Manager or Global Customer Support to cancel your subscription.

Turn off renewal for free trials

1. Log in to your GoToWebinar account.
2. Select My Account in the top navigation.
3. On the My Account page, click Change Plan in the Plan Details section.
4. On the next page, select the "Cancel after my GoToWebinar Free Trial ends" option and click Continue.
5. On the Cancel after Trial page, click Cancel after Trial. You will see a message saying that your request has been processed and that after your free trial ends, your service will be canceled and you won't be charged for a plan. You will also receive a confirmation email.
My Account

Plan Details
GoToMeeting Free Trial
25 attendees
1 organizer seat
- Automatically subscribes to Monthly Plan on Dec 6, 2013
- Visa – 1111 will be charged $49.95 USD, tax not included

Login Info
coleen.lai-hh@jedix.com
Password ********

Personal Info
Henry Health
Primary Language: English
Time Zone: Pacific Standard Time

Billing Info
Visa – 1111
Expires 10/2016
Henry Health
7414 Hillside Ave
Goleta, CA 93117-2583
United States
Phone: 800-111-111

What do you want to do?
- Change my plan or seats
  - Cancel after my GoToMeeting plan ends

Cancel after Your Trial Ends?
May we suggest GoToMeeting Essentials?
Hold unlimited online meetings with up to 5 attendees for $19.99 USD/mo. If you don’t need recording or to meet with 25 attendees, perhaps GoToMeeting Essentials is a better fit.

Questions?
Contact Global Customer Support

Your Request Has Been Processed
After your GoToMeeting free trial ends on Dec 6, 2013, your service will be canceled and you will not be charged for a plan. We sent a confirmation email to coleen.lai-hh@jedix.com.

You will not be able to access scheduled meetings or generate reports once your plan expires.
Turn off renewal for paid plans

1. Log in to your GoToWebinar account.
2. Select My Account in the top navigation.
3. On the My Account page, click Turn Off Renewal in the Plan Details section.
4. On the Turn Off Renewal page, click Turn Off Renewal. Your service will stop, and you will not be automatically charged after your plan ends. You will lose access to scheduled meetings and reports, but you can log in at any time to buy another plan. You will see if your request has been processed on the next page.
Renew your plan

1. **Log in** to your GoToWebinar account.
2. Select **My Account** in the top navigation.
3. On the My Account page, click **Renew Your Plan** in the Plan Details section.
4. To edit your plan, click **Edit** next to Plan Details. On the Confirm Your Plan page, click **Purchase Now**. You will be billed automatically on your billing start date.
What's New?


- Changes to automatic software updates
- New legal text in the Labs Consent Dialog
- New audio Sound Check Wizard in the Audio Pane
- Audio options now available in the hallway
- New Welcome Mat window
- Fixed an issue where organizers did not see the "Remember me" check box when they entered their name and email address
- Fixed an issue where more than 9 digits could be entered as a Meeting ID
- Various other fixes and improvements

What's New in 6.0 – November 14, 2013

- New Labs menu that allows you to try out exciting new features like video sharing, profile pictures, pane undocking, sharing a rectangle of your screen and showing your Control Panel to attendees!
- "Remember me" check box on the Log In page selected by default
- Ability to install the GoToMeeting Codec at the end of session
- Quicker launch into session
- New feedback survey
- Less information required to enter a session
- Fixed an issue where Mac users would experience crashes

What's New – November 1, 2013

- Ability for registrants to unsubscribe from emails from both co-organizers and organizers on an account
- Storage space for recordings now clearly displayed in the left navigation of the My Recordings page
- Pagination on the My Webinars page when there are more than 20 webinars listed
- Fixed an issue for viewing all past webinars
- Fixed an issue where registrants would not show up in the Recording report

What's New – September 9, 2013

- Ability to provide a survey link in specific follow-up emails
- Fixed an issue where Confirmation emails in German, French, Spanish or Italian
- Fixed an issue in Reminder emails for the co-organizer's full name
- Fixed an issue in Outlook that caused line breaks

What's New in v5.9 – September 6, 2013

- Ability to host up to 1,000 attendees using HDFaces for GoToWebinar

What's New in v5.8 – July 12, 2013

- Ability to automatically install upgrades
- Fixed issues that caused various in-session crashes
- Fixed an issue that prevented some organizers from starting meetings or webinars
What's New – May 17, 2013

- Themes for registration and confirmation pages – organizers can now customize the themes for webinar branding
- Fixed an issue where reminder emails only listed the first webinar in a series
- Fixed an issue that caused an error when generating webinar reports
- Fixed an issue that caused custom images in GoToWebinar invitations to appear larger than the uploaded size
- Other various bug fixes and improvements

What's New – April 12, 2013

- Ability to create password-protected webinars
- Option to send confirmation emails
- Option to include recordings in follow-up emails to attendees and/or absentees
- Fixed an issue that sometimes prevented organizers from running reports
- Various other bug fixes and improvements
Start, Schedule and Manage Webinars

Schedule a Webinar

Scheduling a webinar is easy! Schedule one-time sessions, webinar series or webinar sequences from the GoToWebinar website.

Schedule a webinar session, series or sequence

1. Log in to your GoToWebinar account.

2. On the My Webinars page, click the Schedule a webinar button. Or, you can select Schedule a Webinar in the left navigation.

3. On the Schedule a Webinar page, enter a title and description for your new session – the description is used on the registration page and in the invitation email you send to registrants.

4. Select the Type of session you want to schedule:
   - One Session – Attendees register once to attend a session.
   - Series – Attendees can choose which dates to attend when registering for a webinar with multiple sessions.
   - Sequence – Attendees can register once to attend all webinar sessions in the sequence.

5. If you select Series or Sequence, you can choose how frequently the webinar occurs by using the Occurs drop-down menu:
   - Daily – Webinar sessions occur consecutively every day from the start date to the end date.
   - Weekly – Webinar sessions occur once at the same time and day every week.
   - Monthly – Webinar sessions occur at the same time for every date or day every month (e.g., 1st of every month or first Wednesday of every month).
   - Custom Schedule – Webinar sessions occur in random intervals.

6. Select the Start Date, Start Time and End Time.

7. Use the Webinar Time Zone drop-down menu to select the time zone that the session will be held in.

8. When you’re done, click Schedule.
Schedule a Webinar

Title: New Webinar

Description:
The description will be used in your webinar invitation email and registration page.

Type
One Session | Series | Sequence

Attendees will choose which dates to attend when registering for the webinar.

Occurs
- Daily
- Weekly
- Monthly
- Custom Schedule

Start Time: 6:00 PM
End Time: 7:00 PM

Webinar Time Zone
(GMT-08:00) Pacific Time (US and Canada); Tijuana

Schedule
Customize Your Webinar

After you've scheduled a webinar, you can customize your webinar settings!

Edit the title and description

1. [Log in](#) to your GoToWebinar account.
2. Select My Webinars in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, click Edit in the Title and Description section to change the title or description.
4. On the Edit Title and Description page, make your changes, and click Save. Select the "Notify all participants of these changes" check box to alert your registrants of the change via email.

Edit the date and time of a session

1. [Log in](#) to your GoToWebinar account.
2. Select My Webinars in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, click Edit in the Date and Time section to change the date and/or time of the session.
4. On the Edit Date and Time page, make your changes, and click Save. Select the "Notify all participants of these changes" check box to alert your registrants of the change.
Add another session to a webinar series or sequence

1. [Log in](#) to your GoToWebinar account.
2. Select [My Webinars](#) in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, the Date and Time section displays each session and a list of registrants in the webinar series or sequence.
4. To add another session to the webinar, click **Add another session**. On the Add Another Session page, choose the time and date. Click **Save**.

Add a session to your calendar

1. [Log in](#) to your GoToWebinar account.
2. Select [My Webinars](#) in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, click **Add to calendar** in the Date and Time section. An invitation email will launch in your default email client that you can save as a reminder for yourself.

Cancel a session

1. [Log in](#) to your GoToWebinar account.
2. Select [My Webinars](#) in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, the Date and Time section displays each session in a webinar series or sequence. Click the Cancel icon next to the session(s) you want to cancel.

You can customize the cancellation email that is sent to registrants. After you click **Yes** when prompted to confirm the cancellation, you'll be taken to the Send Webinar Cancellation Email page where you can customize the text of the email's subject and body.
4. To cancel the entire webinar, click **Cancel Webinar** at the top of the Manage Webinar page.
5. When prompted to confirm the webinar cancellation, click **Yes**.
Change the audio options for a webinar

1. **Log in** to your GoToWebinar account.
2. Select **My Webinars** in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, click **Edit** in the Audio section.
4. On the Manage Audio page, make any necessary changes to the audio options for the webinar.
5. Select the "Notify participants of these changes" check box to notify your registrants of the audio changes.
6. Click **Save**.

Customize the branding and theme for the webinar

1. **Log in** to your GoToWebinar account.
2. Select **My Webinars** in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, click **Edit** in the Branding section.
4. On the Branding and Theme page, you can customize your webinar:
   - **Upload your own logo to increase attendee response rates**: Click **Choose File**, and select an image. Your image can be up to 400 x 200 pixels and 100KB in size in either .GIF or .JPG format.
   - **Upload an image to customize your theme**: Click **Choose File**. Your image can be up to 200 x 200 pixels and 100KB in size in either .GIF or .JPG format.
   - **Create a color theme**: Select Custom from the Theme drop-down menu and choose a color for the Background, Header Font and/or Border.
   - **Display the names and photos of presenters speaking at the webinar before it starts**: Enter a presenter’s name in the provided field and upload a photo of the presenter. Your image can
be up to 100 x 100 pixels and 100KB in size in either .GIF or .JPG format. Click **Add another presenter** to add more names and photos, or **Remove presenter** to delete the presenter.

5. Once you're done, you can preview your changes by clicking **Preview**.

6. Click **Save** to apply your changes to the webinar.

Your branding will appear on registration pages, emails and in the Waiting Room (a virtual room where attendees wait for the session to begin).
Add panelists

1. **Log in** to your GoToWebinar account.
2. Select **My Webinars** in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, click **Edit** in the Panelists section.
4. On the Panelists page, enter the name and email address of a panelist. Panelists may speak during the webinar and answer assigned questions.
   - To add more speakers, click **Add Another Panelist**.
5. Click **Save**. Your panelists will receive an invitation email for practice sessions and the webinar.

Set Default Audio Options

You can set the default audio options for all your future upcoming sessions. Changing your audio options will not affect your previously scheduled sessions – it will only affect future scheduled sessions. You have 2 audio options: **Use built-in audio conferencing** or **Use my own conference call service** – you can choose one or the other but not both. If you choose to provide your own conference call service, you must provide your own telephone numbers for participants, and you won't have access to built-in audio conferencing (VoIP, long distance and toll-free numbers).

Use built-in audio conferencing (VoIP, long distance and toll-free numbers)

If you select **Use built-in audio conferencing**, you can select **VoIP**, **Long distance number for** and/or **Toll-free number for** (if you have Integrated Toll-Free audio service) to customize the default audio settings to best fit your needs.

- **VoIP** – Your participants can use microphone and speakers to connect to audio through their computer.
- **Long distance number** – Your participants can use a telephone to dial in to the audio conference using a long distance number. You can choose which countries to provide long distance numbers for your attendees.
- **Toll-free number** – Your participants can use a telephone to dial in to the audio conference using a toll-free number. You can choose which countries to provide toll-free numbers for your attendees.
Provide long distance and/or toll-free numbers for more countries

2. Select **Settings** from the left navigation.

3. On the Settings page, make sure the **Long distance number for** option or **Toll-free number for** option is selected, and then click **Edit**.

4. In the "Include Long Distance Numbers for" or "Include Toll-Free Numbers for" box, you can select additional countries. To select all countries available, select the check box next to Country.

5. Once you’re finished, click **Done**. When you return to the Settings page, you'll see the additional countries you added next to the long distance option.

6. To apply these settings for future sessions, click **Save**. Your previously scheduled sessions will not be affected by these changes.
Use my own conference call service

2. Select **Settings** from the left navigation.

3. On the Settings page, select the **Use my own conference call service** option. Choosing this option disables the built-in audio conferencing option.

4. Enter your own conference call info into the Attendee Phone Number field, and then click **Save**. Your attendees will use the conference call info you provide to connect to the audio conference.

5. When you're done, click **Save**.
**Integrated Toll-Free Audio Service**

Organizers can host sessions using GoToMeeting's integrated audio and provide VoIP, toll (long distance) numbers and/or toll-free numbers.

Integrated Toll-Free audio service must be purchased separately from your GoToWebinar plan. If you have a GoToMeeting corporate plan and your billing address is based in the U.S., U.K., Canada or Australia, you may purchase Integrated Toll-Free audio online.

Organizers incur per-minute changes for each attendee who uses the Integrated Toll-Free audio service.

**Calculating toll-free minutes**

Per-minute charges apply to all participants who dial in with the toll-free option. Those who join by regular toll (long distance) numbers are charged rates based on their own long distance provider. There are no additional charges for those who join a session using VoIP.

To minimize billing, any attendee who joins a session before the organizer starts the event is disconnected after 15 minutes of inactivity. If the session is cancelled and never started by the organizer, then no charges are incurred. However, if an organizer joins the session, even if was never started, the account is charged for the organizer's minutes, along with the minutes incurred by any attendees waiting for the event to start.
Available international countries with Integrated Toll-Free audio

See the available international toll-free and long-distance (toll) numbers.

Share Webinars, Manage Registration and Send Emails

Once you’ve scheduled and set up your webinar, you can invite attendees, as well as set up and manage registration.

Invite your attendees

1. Log in to your GoToWebinar account.
2. Select My Webinars in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, select Invite on the top-left corner.

Or, scroll down to the Share Your Webinar section, and select a delivery option:

- Email Me the Invitation: Email the webinar registration info to yourself. Then send the invite to attendees.
- Copy Webinar Information: Copy and paste the webinar registration information onto a web page, document or wherever you’d like. To select all the text shown, click Select All to highlight everything, and then copy and paste it by right-clicking the highlighted text and selecting Copy. Or, you can select the highlighted text and press Ctrl + C on your keyboard to copy and then Ctrl + V to paste it somewhere.

View the Registration URL and Webinar ID

1. Log in to your GoToWebinar account.
2. Select My Webinars in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, scroll down to the Share Your Webinar section where the Registration URL and Webinar ID is shown. You can click the Registration URL to see the registration form that your attendees see.
Track registration sources

1. **Log in** to your GoToWebinar account.

2. Select **My Webinars** in the left navigation. Click the title of the webinar.

3. On the Manage Webinar page, scroll to the Share Your Webinar section and copy the Registration URL.

4. Add the source to the end of Registration URL (e.g. https://attendee.gotowebinar.com/register/1751482784943615232?source=email). You can add sources to the Registration URL such as "?source=google", "?source=facebook", "?source=linkedin", etc. The source used cannot exceed more than 128 characters.

5. To view which sources registrants used to find your webinar, click **Generate Reports** in the left navigation and select **Registration Report**.

6. Select **Generate Excel Report** for the webinar you would like to track sources for. The Registration Report will display which source the registrant used.
Registration settings

1. Log in to your GoToWebinar account.
2. Select My Webinars in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, scroll down to the Share Your Webinar section.
4. Click Edit in the Registration Settings section to manage registration.
   - Add additional registration fields (first name, last name and email address are always required)
   - Create, edit sort or delete custom registration questions
   - Automatically or manually approve registrants
   - Set up registration notification emails

Add additional registration fields

1. On the Manage Registration page, you can select additional required or optional registration fields for your attendees to fill out:
   - Address
   - City
   - State/Province
   - Zip/Postal Code
   - Country
   - Phone
   - Industry
   - Organization
   - Job Title
   - Purchasing Time Frame
   - Role in Purchase Process
   - No. of Employees
   - Questions and Comments
2. Unless you select the "Required" check box next to each additional registration field, the added fields will be optional by default.

3. Click Save. You can click the Registration URL on the Manage Webinar page to see what your registrants will see.

Create, edit, sort or delete custom registration questions

1. On the Manage Registration page, go to the Create Your Own Question section. You're prohibited from soliciting confidential personal information (credit card information, social security numbers, etc.) in your registration questions.

2. Click New Question to create a registration question.
3. Select the type of question:
   - **Short Answer**: Provides registrants with an open-ended answer.
   - **Multiple Choice (One Answer)**: Gives registrants the choice of selecting one answer from multiple options available.

4. Enter your question in the Question field. If you choose the multiple choice question type, enter at least 2 answers in the Answers field. If you want to add more than 3 answer options, click **Add another answer**.

5. Click **Create** to save your question.
   - To edit your question, click the actual question on the Manage Registration page. After you've made changes, click **Update**.
   - To make your custom question required, select the "Required" check box next to the question on the Manage Registration page.
   - To delete your question, click the Remove icon next to the question on the Manage Registration page.
   - To change the order of the questions, drag and drop a question up or down the list of questions on the Manage Registration page.

6. Click **Save**.

**Automatically or manually approve registrants**

1. On the Manage Registration page, scroll down to the Approval section.

2. Select 1 of the approval options:
   - **Automatic Approval**: Registrants will immediately receive information on how to join the webinar once they register.
   - **Manual Approval**: You must approve registrants before they receive information on how to join the webinar.

3. If you'd like to receive an email every time someone registers, select the "Registration Notification" check box. If you don't select this option, you can return to the Manage Webinar page where you can click **Manage** or the registrant number link in the Manage Registration section to approve or deny registrants.

4. Click **Save**.

**Direct registrants to a confirmation page**

1. On the Manage Webinar page, scroll down to the Registration Settings section.

2. Click **Edit** next to Registration Settings.

3. Select 1 of the following options:
   - **Direct registrants to the GoToWebinar confirmation page**: Registrants will see a standard GoToWebinar confirmation page.
   - **Direct registrants to your own confirmation page**: Enter the website you would like registrants to be directed to post-registration.
4. Click **Save** to save your changes.

**Create a webinar password**

1. On the Manage Webinar page, click **Edit** next to Registration Settings.
2. Select the "Create a webinar password" check box to require your attendees to enter a password before joining a webinar.
3. Enter your password. You must send the password to your registrants or they won't be able to enter the webinar. For security reasons, GoToWebinar doesn't send the password for you.
4. Click **Save** to save your changes.

**Registration tracking**

1. **Log in** to your GoToWebinar account.
2. Select **My Webinars** in the left navigation. Click the title of the webinar.
4. On the Manage Webinar page, scroll down to the Share Your Webinar section.
5. Click **View** in the Tracking Registrants section:
   - **Set the approval process**
   - **Set up registration notification emails**

**Approve, deny or cancel registration**

1. On the Manage Webinar page, scroll down to the Registration Management section.
2. Click **Manage** or the number of registrants to approve or deny registrants.
3. On the Registrants page, select one or multiple registrants from the Pending Approval tab, and then click Approve or Deny.

Approved registrants will receive a confirmation email and will be moved to the Approved tab on the Registrants page. You can still cancel their registration after they've already been approved, and they will be moved to the Deny tab.

Denied registrants will be moved to the Deny tab, where you can still approve them if you change your mind.

- To view a registrant's details, click the registrant's name on the Registrants page:
  - Status: Waiting Approval, Approved or Denied
  - Registered: Date that the person registered for the webinar
  - Email: Registrant's email address
  - Registration Answers: Submitted responses to custom registration questions
- To export registration data to Excel, click Registration Report on the Registrants page.
- To resend the confirmation email, click a registrant's name from the Registrant's page, and then click Resend Confirmation Email on the Registrant Details page.

### Emails

1. Log in to your GoToWebinar account.
2. Select My Webinars in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, scroll down to the Email section.
4. Click Edit next to the type of email you want to send.
   - Send confirmation emails to registrants
   - Send reminder emails to registrants and panelists
   - Send follow-up emails to attendees

#### Send confirmation emails to registrants

1. On the Manage Webinar page, scroll down to the Emails section.
2. Click Edit in the Confirmation Email to Registrants section.
3. On the Confirmation Emails page, you can choose if you want to send a confirmation email to registrants by selecting the “Send Confirmation Email to Registrants” check box.
4. If you have selected the “Send Confirmation Email to Registrants” check box, you can then edit the email subject and enter custom text.

5. Click **Save**. You can view your changes in the Emails section on the Manage Webinar page. To preview how the email will look to registrants, select **Preview**.

If you want to resend confirmation emails, return to the Manage Webinar page and click **Manage** next to Tracking Registrants.

**Send reminder emails to registrants and panelists**

1. On the Manage Webinar page, scroll down to the Emails section.

2. Click **Edit** in the Reminder Emails section.

3. On the Reminder Emails page, schedule your reminder email to be sent out to registrants and panelists by choosing one or more options:
   - 1 hour before the webinar start date and time
   - 1 day before the webinar start date and time
   - 1 week before the webinar start date and time

You can select **Send me a copy of the Reminder Email** if you’d like to receive a copy as well. To preview how the email will look to attendees, select **Preview**.

4. You can enter custom text in the provided field. You can customize reminder emails until they’re sent to attendees.

5. Click **Save**. You can view your changes in the Emails section on the Manage Webinar page. To preview how the email will look to attendees, select **Preview**.
Send follow-up emails to attendees and absentees

1. On the Manage Webinar page, scroll down to the Emails section.

2. Click **Edit** next to Follow-Up Email to Attendees. If you want to send follow-up emails to absentees (registrants who don't show up), click **Edit** next to Follow-Up Email to Absentees.

3. On the Follow-Up Email page, select the "Send Follow-up Email to Attendees" or "Send Follow-up Email to Absentees" check box. One follow-up email can be sent to attendees up to 7 days after the webinar's scheduled end date.

4. Then choose when you'd like to send the follow-up email:
   - 1 day after scheduled end date
   - 2 days after scheduled end date
   - 3 days after scheduled end date
   - 4 days after scheduled end date
   - 5 days after scheduled end date
   - 6 days after scheduled end date
   - 7 days after scheduled end date
You can select **Send me a copy of the Follow-Up Email** if you'd like to receive a copy as well.

5. Enter the email subject and body text in the provided field to customize the email.

6. Click **Select a Recording** to attach a recording to your email. You can upload recordings on the My Recordings page.

7. Click **Save**. You can view your changes in the Emails section on the Manage Webinar page. To preview how the email will look to attendees, select **Preview**.
Engage Attendees with Polls and Surveys

You can engage your attendees by creating custom Polls and Surveys. You can create up to 20 Polls before the session or in-session on-the-fly and add up to 25 questions to a Survey. After you close a Poll, you can choose to show the Poll results immediately to everyone or at a later time during the session.

Learn how to launch a Poll, show Poll results and create Polls in-session.

Create, edit, sort and delete Polls before a session

1. Log in to your GoToWebinar account.
2. Select My Webinars in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, scroll down to the Engage Your Attendees section. Click Edit next to Polls.
4. On the Create a New Poll page, choose the type of Poll:
   - Multiple Choice (One Answer)
   - Multiple Choice (Multiple Answers)
5. Enter a question into the Question field.
6. Enter at least 2 answers in the Answer field.
7. Click Save.
8. To create another Poll for the session, click Edit on the Manage Polls page, and then click Create New Poll. You can add up to 20 Polls per webinar.
9. To view the Poll results, create an Attendee Report after the session ends.
10. To edit Polls, go to the Manage Webinar page, click Edit next to Polls and click the Poll question. Make your changes on the Edit Poll page, and then click Save.
11. To change the sort the order of Polls, go to the Manage Webinar page, click Edit next to Polls, and change the order of the polls on the Manage Polls page. Click Update Order when you’re done.
12. To delete a Poll, go to the Manage Trainings page, click Edit next to Polls, and click the Remove icon next to the Poll on the Manage Polls page.
Create, edit, sort and delete Surveys before a session

1. **Log in** to your GoToWebinar account.

2. Select **My Webinars** in the left navigation. Click the title of the webinar.

3. On the Manage Webinar page, scroll down to the Engage Your Attendees section. Click **Edit** next in the Surveys section.


5. Choose the Survey question type:
   - Multiple Choice with One Answer (2 or more answers are required)
   - Multiple Choice with Multiple Answers (3 or more answers are required)
   - Rate on a Scale of 1 to 5
   - Short Answer

   If you'd like to provide more than 3 answer options, click **Add another answer**.

6. When you're ready to save your first question and answer, click **Add to Survey**. To add another question, click **New Question** on the Survey page. Repeat step 5 to add more questions to the Survey.

7. When you've completed creating your Survey, click **Save**.
• **To edit a Survey question or answer**, click a question on the Survey page. Make your changes, and then click **Save**.

• **To change the order of Surveys**, go to the Manage Webinar page, and click **Edit** next to Surveys. On the Survey page, drag and drop a Survey up or down in the list as you’d want it to appear to attendees. Click **Save**.

• **To delete a Survey**, go to the Manage Webinar page, and click **Edit** next to Surveys. On the Survey page, click **Delete Survey**.

• **To preview a Survey**, go to the Manage Webinar page, and click **Edit** next to Surveys. On the Survey page, click **Preview** to see how the Survey will appear to your attendees.
Choose when you want to send out a Survey

1. Log in to your GoToWebinar account.

2. Select My Webinars in the left navigation. Click the title of the webinar.

3. On the Manage Webinar page, scroll down to the Engage Your Attendees section. Click Edit next in the Surveys section.

4. On the Survey page, scroll down to the Settings section.

5. Choose when you want to send out the Survey:

   - After the webinar: For a one-session webinar, the Survey is sent out after the webinar ends. For a webinar series, the Survey is sent out after each session ends. For a webinar sequence, the Survey is sent out after all sessions in the sequence have ended.

   - In the Follow-up Email: All registrants will receive a link to the Survey in the follow-up email.

5. Click Save. You can view your changes in the Survey section on the Manage Webinar page.

Related

Schedule Similar Webinars

If you already have a scheduled webinar that's set up with Polls, Surveys, emails, etc., you can schedule a similar webinar or copy a webinar so that all your settings and customizations carry over to another webinar. It makes it easy to schedule a webinar that's similar to one of your previously scheduled webinars.

Schedule a similar webinar

1. Log in to your GoToWebinar account.

2. Select My Webinars in the left navigation.

3. Click the title of the webinar in the Upcoming Webinars tab.

4. On the Manage Webinar page, select Schedule Similar Webinar from the top -left corner. You can schedule a similar upcoming or past webinar.

5. On the Schedule Similar Webinar page, enter a title and description, and choose the session time, start date, start time, end time and time zone.

6. Then click Schedule. All your settings from the previously scheduled webinar will carry over to the newly scheduled webinar.
Copy webinar

1. Log in to your GoToWebinar account.

2. Select My Webinars in the left navigation.

3. On the Past Webinars tab, click Copy next to the webinar you want to copy. Only webinars with a start date in the past 90 days are displayed.

4. On the Schedule Similar Webinar page, enter a title and description, and choose the session time, start date, start time, end time and time zone.

5. Then click Schedule. All your settings from the previously scheduled webinar will carry over to the newly scheduled webinar.
Upcoming Webinars

You can get an overview of your upcoming scheduled webinars, as well as start your webinars from the My Webinars page.

View upcoming webinars

1. Log in to your GoToWebinar account.
2. Select My Webinars in the left navigation.
3. On the Upcoming Webinars tab, you can view all your scheduled upcoming webinars:
   - Date
   - Time
   - Title
   - Registrants

You can hover over the Information icon to get a glimpse of the webinar:
   - Title
   - Date
   - Scheduling Organizer
   - Registrants
   - Registration URL
   - Webinar ID

You can also start a webinar from the My Webinars page by clicking Start next to a webinar.

Past Webinars

You can view your previously held webinars that have ended and copy webinars from the My Webinars page. Past webinars will be displayed on the My Webinars page after the scheduled end time. If you recorded a webinar, you can go to the Past Webinars tab on the Manage Webinars page to edit the follow-up email to include the recorded webinar.

View past webinars

1. Log in to your GoToWebinar account.
2. Select My Webinars in the left navigation.
3. On the Past Webinars tab, you can view all your previously held webinars. If you click a webinar title, you can access the details for that webinar.

Also, you can copy a webinar by clicking Copy next to a webinar so that you can schedule a similar webinar that includes the settings and customizations from one of your past webinars.

Practice a Webinar

If you're using a Windows computer, you can start a webinar in practice mode before you actually start the live webinar session. Attendees cannot join your practice session, but you can run through the webinar with other panelists and organizers to perfect it. If you practice a webinar up until the webinar's scheduled start time, you can easily start the webinar while you're in practice mode.

Start a practice webinar (Windows only)

1. Log in to your GoToWebinar account.
2. Select My Webinars in the left navigation. Click the title of the webinar.
3. On the Manage Webinar page, click Practice in the top-right corner.
4. The GoToWebinar application should automatically begin downloading. We recommend installing or upgrading Java on Windows computers to quickly connect to webinar sessions.
5. You can click the Show My Screen button to begin Screen Sharing.

*To start the live webinar while you're in practice mode, click Start at the top of your Control Panel. When you're prompted to start the webinar now, click Start.*
Start a Scheduled Webinar

You can start a scheduled webinar from either the GoToWebinar website or from your desktop if you already have GoToWebinar installed.

Start a scheduled webinar from the web

1. **Log in** to your GoToWebinar account.

2. On the My Webinars page, click **Start** next to the webinar you want to host. Or, you can right-click the GoToWebinar daisy icon in the system tray, select **My Webinars > Start**.
3. If you're on a Windows computer, GoToWebinar will automatically launch into session if you have Java enabled. We recommend installing or upgrading Java to quickly connect to sessions. If you're on a Mac and have never joined a session before, you'll first need to download the Citrix Online Launcher file.

4. To start the webinar, enter your email address and password, and then click Log In. You should see the GoToWebinar Control Panel on the right-side of your screen where you can manage the webinar.

Start a scheduled webinar from the desktop application

1. If you already have GoToWebinar installed on your computer, you can right-click the GoToWebinar daisy icon in your system tray, and select My Webinars.

2. You'll be taken to the My Webinars web page. Click Start next to the session you want to begin hosting.

3. If you're on a Windows computer, GoToWebinar will automatically launch into session if you have Java enabled. We recommend installing or upgrading Java to quickly connect to sessions. If you're on a Mac and have never joined a session before, you'll first need to download the Citrix Online Launcher file.

4. To start the webinar, enter your email address and password, and then click Log In. You should see the GoToWebinar Control Panel on the right-side of your screen where you can manage the webinar.
Upload, Share and Delete a Recording

After you've recorded a session, you can store your recordings and share the link with your attendees. By default you have 3GB of storage space for your recordings. You can upload a recording file no larger than 1GB at a time. You can also distribute a recording and send or upload the recording wherever you'd like. Although you can record sessions on Macs running OS X 10.6 (Snow Leopard) or higher, you can only upload and stream .MOV files using Mac OS X 10.7 (Lion).

Upload a recording

1. Log in to your GoToWebinar account.
2. Select My Recordings in the left navigation.
3. On the My Recordings page, click the Upload Recording button to browse for and select the recording file from your computer. By default GoToWebinar recordings are saved to the Documents folder on the computer where you recorded the session.
4. Once the recording file has uploaded successfully to My Recordings, you can view the upload date, size, recording title and the number of views.

Share a recording

1. Find the recording on the My Recordings page.
2. Hover over the Share icon.
3. Copy and paste the link in the bubble tool tip.
4. Send the link to your registrants. To view the recording, registrants must provide their first name, last name and email address to register to view the recording. You can return to the My Recordings page and click the number of views link to see the number of recording views and generate a .

Delete a recording

1. Find the recording on the My Recordings page.
2. Select the Remove icon.
3. In the "Confirm Delete" box, select Yes to permanently delete the recording.
Attach a recording to a follow-up email

1. On the My Webinars page, choose a webinar from either the Upcoming Webinars tab or the Past Webinars tab. If you want to include a link to a recorded webinar, you'll need to wait until after you've hosted the session and then select the **Past Webinars tab** to edit the follow-up email.

2. On the Manage Webinar page, scroll down to the Emails section.

3. Click **Edit** next to Follow-Up Email to Attendees. If you want to send follow-up emails to absentees (registrants who don't show up), click **Edit** next to Follow-Up Email to Absentees.

4. On the Follow-Up Email page, select the "Send Follow-up Email to Attendees" or "Send Follow-up Email to Absentees" check box. Only 1 follow-up email can be sent to attendees up to 7 days after the webinar's scheduled end date. If you've already sent a follow-up email for a webinar, you won't be able to send another one with a link to the recorded webinar.

5. Then choose when you'd like to send the follow-up email:
   - 1 day after scheduled end date
   - 2 days after scheduled end date
   - 3 days after scheduled end date
   - 4 days after scheduled end date
   - 5 days after scheduled end date
   - 6 days after scheduled end date
   - 7 days after scheduled end date

6. Enter the email subject and body text in the provided field to customize the email.

7. Click **Select a Recording** to attach a recording to your email. The Recorded Webinar Report will show how many recipients viewed your attached recording.

8. Click **Save**. You can view your changes in the Emails section on the Manage Webinar page. To preview how the email will look to attendees, select **Preview**.
Note: If you're an organizer on a corporate account, only the organizer who originally added the recording to the follow-up email will be able to delete it. Co-organizers won't be able to delete a recording that's been added by someone else, but co-organizers can still add a recording to a follow-up email if one hasn't already been added.

View remaining storage space

1. In the left navigation, find the Storage Space widget.

2. By default, you have 2GB of storage space for materials and recordings. You can see how much space your files use and how much space remains.
Cancel Webinar

You can cancel a webinar at anytime if you no longer want to hold it. For a webinar series or sequence, you have the option of canceling either all sessions or individual sessions.

Cancel a webinar, series or sequence

1. Log in to your GoToWebinar account.

2. Select My Webinars in the left navigation. Click the title of the webinar.

3. On the Manage Webinar page, select Cancel at the top of the page. Clicking Cancel for a webinar series or sequence will cancel all sessions. To cancel specific sessions in a series or sequence, click the Cancel icon next to the Webinar ID in the Date and Time section.

4. When you're prompted to confirm the webinar cancellation, click Yes. You can then customize the text in confirmation email that is sent to registrants.
Mobile Devices

GoToMeeting App for iOS

The GoToMeeting app for iOS allows you join GoToMeeting or GoToWebinar sessions from an iPad, iPhone or iPod free of charge. Organizers can also start, schedule and edit meetings directly from the app.

Schedule a meeting from an iOS device

1. Log in to your account from the GoToMeeting app for iOS. If you don't already have the app installed, download the free GoToMeeting app for iOS.

2. Tap the Plus icon on the My Meetings screen.

3. You can then select whether or not it is a recurring meeting, choose the audio and create a meeting password (optional).
4. When you're finished, tap **Done**. You can then invite others by tapping **Send Invitation**.
Edit a scheduled meeting from an iOS device

1. Log in to your account from the GoToMeeting app for iOS. If you don't already have the app installed, download the free GoToMeeting app for iOS.

2. Tap the Edit button on the My Meetings screen.

3. Tap the Arrow icon next to the meeting you would like to edit.
4. You can then edit the name of the meeting, whether or not it is a recurring meeting, the time/date of the meeting, the audio and the meeting password.

5. When you're finished, tap the **Done** button to save your changes.
View scheduled meetings from an iOS device

1. Log in to your account from the GoToMeeting app for iOS. If you don't already have the app installed, download the free GoToMeeting app for iOS.

2. Tap My Meetings to see a list of your previously scheduled meetings, including the meeting subject, start date and start time.

Start scheduled meetings from an iOS device

1. Log in to your account from the GoToMeeting app for iOS. If you don't already have the app installed, download the free GoToMeeting app for iOS.

2. Tap My Meetings to see a list of your scheduled meetings.

3. Select the meeting you want to start and tap Start when prompted.
Cancel a scheduled meeting from an iOS device

1. Log in to your account from the GoToMeeting app for iOS. If you don't already have the app installed, download the free GoToMeeting app for iOS.

2. Tap the **Edit** button on the My Meetings screen.

3. Tap the Minus icon \( \text{−} \) next to the meeting you would like to delete.

4. Tap the **Delete** button to delete this meeting.
Start an instant meeting from an iOS device

1. Log in to your account from the GoToMeeting app for iOS. If you don't already have the app installed, download the free GoToMeeting app for iOS.

2. Tap My Meetings > Meet Now to start an instant meeting. You can then invite attendees to join your meeting.
GoToMeeting App for Android

Schedule a meeting from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.

2. Tap the Schedule a Meeting button on the Meetings screen.

3. You can then select whether or not it is a recurring meeting, choose the audio and edit the phone numbers.

4. When you’re done, tap Schedule.
Edit a scheduled meeting from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.

2. Tap the name of the meeting you would like to edit. Then tap Edit.

3. You can then edit the name of the meeting, the start date and time and the audio for that meeting.

4. When you’re finished making changes, tap Save.

View scheduled meetings from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.

2. Your previously scheduled meetings will appear. Remember that you can only start meetings that you previously scheduled from your Windows or Mac desktop on your Android device.
Invite others from an Android device before a meeting

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don't already have the app installed, download the free GoToMeeting app for Android.

2. Tap the name of the meeting and then tap the **Invite** button. You can choose to send an email invitation through any email application installed on your Android device.
Start scheduled meetings from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.

2. Your previously scheduled meetings should appear. Remember that you can only start meetings that you previously scheduled from your Windows or Mac desktop on your Android device.

3. Select the meeting you want to start and click Start when prompted.

Cancel a scheduled meeting from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.

2. Tap the name of the meeting you would like to delete and then tap the Delete button.

3. When prompted to delete the meeting, tap Delete.
Start a Meet Now from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don't already have the app installed, download the free GoToMeeting app for Android.

2. If you've previously scheduled meetings from your Windows or Mac desktop, they should appear. To start an instant meeting, tap Meet Now.
GoToMeeting App for iOS Session Features

Some GoToMeeting App for iOS features are only available for those using the app from an iPad. However, many features are accessible from all iOS devices, allowing you to hold a session comparable to a session held from a desktop.

View and manage the Attendee List

1. Tap the Attendee List icon to view the attendees and organizers in-session.

Leave or end a session from an iOS device

1. To leave a session from an iOS device, tap the Leave icon.
2. If you're an attendee, select Leave Meeting to exit the meeting. If you're an organizer, you have 2 options:
   - **End Meeting for Everyone** – Ends the meeting completely and disconnects everyone from the session.
   - **Leave Meeting** – Allows the meeting to continue after you leave by making someone else an organizer.
**Mobile Feature Comparison**

The GoToMeeting app for iOS and the GoToMeeting app for Android both offer different features than those available for GoToMeeting, GoToWebinar and GoToTraining desktop users. Use the chart below to see what is available on each app for iOS, Android and Windows devices.

**GoToMeeting session features:**

<table>
<thead>
<tr>
<th>Features</th>
<th>iOS</th>
<th>Android</th>
<th>Windows RT</th>
<th>Windows Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join a meeting</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Leave a meeting</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Start a meeting</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Schedule a meeting</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>✓</td>
</tr>
<tr>
<td>View a meeting</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Meet Now</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Invite Others</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Promote others to organizer</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Promote others to presenter</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Webcams</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chat</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Attendee list</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View shared screen</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Screen sharing</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drawing tools</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### GoToWebinar session features:

<table>
<thead>
<tr>
<th>Features</th>
<th>iOS</th>
<th>Android</th>
<th>Windows RT</th>
<th>Windows Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register for a webinar</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Join a webinar</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Leave a webinar</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Chat</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Attendee list</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>View shared screen</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Hand raising</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Polls</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Question and Answer</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>

### GoToTraining session features:

<table>
<thead>
<tr>
<th>Features</th>
<th>iOS</th>
<th>Android</th>
<th>Windows RT</th>
<th>Windows Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join a training</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Leave a training</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Polls</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Hand raising</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Tests</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Materials</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Break Timer</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>
Join Sessions

Register for a Session

If you'd like to attend a session as an attendee, you'll first need to register for the session using the Registration URL in your GoToWebinar invitation. After you register, you'll receive a confirmation email with information on how to join the session when it's time.

Register to attend a session

1. Open your GoToWebinar invitation email.
2. Click the Registration URL to open the registration form.
3. Fill out all required fields, including your first name, last name and email address. Then click Register.
4. Once you've successfully registered, you'll see a Registration Confirmation page.
   - If the organizer sets up automatic approval, you'll immediately receive a confirmation email with information on how to join the session.
   - If the organizer sets up manual approval, the organizer must first approve your registration before you'll receive a confirmation email.
   You can add a GoToWebinar appointment to your calendar as a reminder to join the session at the specified time and date.
5. When it's time for the session, just click the Join URL in your confirmation email. Don't share the Join URL with anyone – it's unique to you.
   - If you're registering for a webinar sequence, you can use the same Join URL to join all sessions.
   - If you're registering for a webinar series (where you can choose which sessions to attend), you must use a different Join URL to join each session. The Join URLs will be provided in the confirmation emails that you'll receive for each session once you register.
Join a Session

After you've registered for a webinar, you can easily join the session when it's time. You can join sessions from the web, desktop application or a mobile device!

Join a session from a mobile device

Join a session from your invitation email

1. Open your GoToWebinar confirmation email.

2. Click the Join URL when it's time to start. Don't share your Join URL with anyone – it's unique to you. If the session is not yet open to attendees, you'll see a message that tells you to come back at the scheduled start time.

3. If you're on a desktop computer, you may need to first download the Citrix Online Launcher file for Windows or Mac to launch GoToWebinar.

4. Once you're in-session, choose one of the audio options provided by the organizer to connect to the audio conference. You can choose your preferred audio option from the Audio pane of your Control Panel.
Join a session from the web

1. Go to the GoToWebinar website, and click Join a Webinar.

2. Enter the Webinar ID listed in your confirmation email, and type in your email address. Click Continue.

3. If you're on a desktop computer, you may need to first download the Citrix Online Launcher file for Windows or Mac to launch GoToWebinar.

4. Once you're in-session, choose one of the audio options provided by the organizer to connect to the audio conference. You can choose your preferred audio option from the Audio pane of your Control Panel.
Join a session from the GoToWebinar desktop application

1. If you already have GoToWebinar installed onto your computer, right-click the GoToWebinar daisy icon in your system tray, and select Join.

![GoToWebinar Desktop Application](image)

2. On the "Join a session" dialog, enter the Webinar ID, and click OK.

![Join a session dialog](image)

3. You may need to first download the Citrix Online Launcher file for Windows or Mac to launch GoToWebinar.

4. Once you're in-session, choose one of the audio options provided by the organizer to connect to the audio conference. You can choose your preferred audio option from the Audio pane of your Control Panel.

Join a session from a mobile device

1. Open the GoToMeeting app for Android or GoToMeeting app for iOS. If you don't already have the app installed, you can easily download the free mobile apps.

2. If you know the 9-digit session ID, you can join the session by simply opening the GoToMeeting app and entering your name and the session ID. Or, you can tap the Join URL in your GoToWebinar's invitation email to automatically join.
Session Features

Control Panel and Grab Tab

When you first start or join a session, the Control Panel appears on the right side of your screen. Use the Control Panel to manage your session. To free up space on your desktop, you can collapse the Control Panel and use the Grab Tab to continue to manage your session.

Organizer Control Panel

- **Screen Sharing**: Present a document, PowerPoint presentation or whatever you want to share with the audience.
- **Keyboard and Mouse Control**: Give keyboard and mouse control to someone so they can control your screen.
- **Co-Organizers**: Make someone a co-organizer so that person can present and control the session like you. You can also make someone a panelist so they can speak and present during the webinar and answer assigned questions.
- **Change Presenter**: Change presenters so that someone else can show their screen.
- **Drawing Tools**: Annotate directly on your screen to highlight, call out and draw attention to your document, presentation or whatever you’re sharing.
- **Dashboard**: Monitor the session at-a-glance and quickly view the timer, attendance, raised hands and more.
- **Audience View**: View a thumbnail image of what attendees see when you share your screen.
- **Attendee List**: View the names of all the participants in-session.
- **Audio**: Use the Audio pane to switch between Telephone, Mic & Speakers and/or Conference Call Numbers (if available).
- **Invite Others**: Invite attendees during a session by emailing the invitation or copying and pasting the join information.
- **Polls**: Engage your attendees and focus their attention in-session.
- **Question and Answer**: Allow attendees to ask Questions to organizers during a session.
- **Chat**: Send and receive Chat messages in-session.
- **Recording**: Record the presenter’s screen, audio and shared applications during a session, then upload and store the recording for people to view.
- **Leave and End a Session**: Leave or end a session anytime during the session.
Invite Others

You can invite additional attendees during a session by emailing the invitation or copying and pasting the join information. Attendees who haven't registered must first fill out the required registration fields and submit the registration form before they can join the session that's already in progress. You cannot invite organizers and panelists in-session – you can only invite attendees and promote them to an organizer or panelist after they've registered and joined the session.

Email the GoToWebinar invitation while in-session

1. From the Attendee List pane in the Control Panel, click Invite Others.
2. Then select Email to open the GoToWebinar invitation in your default email client.
3. Enter the attendee's email address to send them the invite with information on how to join the session.

Copy and paste the GoToWebinar invitation while in-session

1. From the Attendee List pane in the Control Panel, click Invite Others.
2. Then select Copy to Clipboard to copy the Join URL and Webinar ID.
3. Paste the content into another email client or application.
4. Send the session information to an attendee.
Test Connection with GoToWebinar

You can test your GoToWebinar connection in-session to determine if you've established a passing connection.

Test your connection in-session (Windows only)

1. Click the GoToWebinar menu, and select Preferences. Or, right-click the GoToWebinar daisy icon in your system tray, and select Preferences.
2. Select the Connection tab, and click Test Connection.
3. The Test Results section displays your connection status.
   - Passed: You've established a connection.
   - Fail: You haven't established a connection.

Having trouble connecting?

You may need to enter your Windows username and password or domain if you have a proxy that prevents you from connecting to GoToWebinar.

If you don't have a proxy, please check to see that you have the minimum system requirements.
Audio

If the organizer schedules a session that gives attendees the flexibility to use different audio options, attendees can use the Audio pane to switch between Telephone and Mic & Speakers. If you're having trouble connecting to the audio conference, see Audio Help.

Use Telephone to connect to the audio conference

You can use a landline or mobile phone to dial in to the audio conference. Once you're in-session, you'll have access to your unique Audio PIN.

1. In the Audio pane of your Control Panel, select the Telephone option.
2. Dial into the audio conference using the provided telephone number.
3. When you're prompted, enter the Access Code, and then press "1".
4. Enter your unique Audio PIN, and then press "#" on your keypad. If you don't enter your Audio PIN, the organizer won't be able to mute you in-session.

- If you want to see if the organizer provided additional numbers (e.g., toll-free numbers), click additional numbers in the Audio pane to access all the phone numbers available for the session.

- If you're having trouble dialing in to the audio conference, click Problem dialing in? in the Audio pane to access alternate telephone numbers from a different network provider.
Use telephone with an alternate phone number

If you're experiencing problems dialing in to the audio conference, you can use an alternate phone number (toll, toll-free and/or international numbers) from a different network provider to connect to the audio conference.

1. In the Audio pane of the Control Panel, click **Problem dialing in?** to access alternate telephone numbers from a different provider.

2. When you're redirected to the Can't Dial in to the Conference? web page, choose your preferred dial-in country if available.

3. Try calling the number provided instead. Toll (long-distance), toll-free and/or international numbers for one or multiple countries may be available, depending on what the scheduling organizer chooses to provide.

If an alternate number is not available, you can still join the audio conference using your built-in microphone and speakers (VoIP) by selecting **Mic & Speakers** in the Audio pane.
# Manage audio via telephone commands (organizers only)

<table>
<thead>
<tr>
<th>Command</th>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>*2</td>
<td>Count</td>
<td>Provides the number of attendees dialed in to the conference.</td>
</tr>
<tr>
<td>*3</td>
<td>On-hold beep controls</td>
<td>Sets the on-hold beeps. Pressing *3 sets the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On-hold beeps on (default).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On-hold beeps off.</td>
</tr>
<tr>
<td>*4</td>
<td>Menu</td>
<td>Provides a menu of available conference commands.</td>
</tr>
<tr>
<td>*5</td>
<td>Listening Modes</td>
<td>Sets listening modes for the audience. Meeting organizers can cycle through three listening modes by pressing *5.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mute: organizers and panelists can unmute themselves by pressing *6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mute: organizers and panelists cannot unmute themselves</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Unmute: organizers and panelists are unmuted (default)</td>
</tr>
<tr>
<td>*6</td>
<td>Mute/Unmute</td>
<td>Mutes the organizer's line. Pressing *6 again will unmute the line.</td>
</tr>
<tr>
<td>*8</td>
<td>Chime Controls</td>
<td>Sets entry and exit chimes. By default, entry and exit chimes are on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Entry chime and exit chime on (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Entry and exit chimes off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Entry chimes off exit chime on</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Entry chime on exit chime off</td>
</tr>
</tbody>
</table>
Manage audio via telephone commands (attendees only)

<table>
<thead>
<tr>
<th>Command</th>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| *3      | On-hold beep controls | Sets the on-hold beeps. Pressing *3 sets the following options:  
|         |                 | • On-hold beeps on (default).  
|         |                 | • On-hold beeps off.                                                      |
| *4      | Menu            | Provides a menu of available conference commands.                        |
| *6      | Mute/ Unmute    | Mutes the participant's line. Pressing *6 again will unmute the line.   |
Use Mic & Speakers (VoIP) to connect to the audio conference (Windows)

Your audio quality may vary depending on your audio software, hardware, operating system and Internet connection. We recommend using a USB headset plugged into your computer and placing your microphone away from other speakers or devices.

1. In the Audio pane of your Control Panel, select the **Mic & Speakers** option to connect to the audio conference over VoIP (requires microphone and speakers).

2. Test your audio hardware and audio input and output by selecting **File>Preferences** next to the **Mic & Speakers** option.

3. In the Preferences window, test your microphone and speakers setup. You'll be muted while you're testing your audio setup. Make sure to select the appropriate device.
   - **Test your microphone setup:** Speak into your microphone. If your microphone works, the audio indicator will turn green.
   - **Test your speakers setup:** Click **Play Sound** to check that you can hear audio from your speakers. If your speakers work, you'll hear sound.

If your microphone or speakers aren't working, try selecting another device that's connected to your computer from the drop-down menu until the audio indicators turn green.

4. Click **OK** when you've verified that your microphone and speakers are working properly.

5. To mute or unmute yourself, click the Mute icon 🗣️ in the Grab Tab.
   - The Mute icon 🗣️ is green when you are unmuted and people can hear you.
   - The Mute icon 🗣️ is gray when you are muted and no one can hear you.

Use Mic & Speakers (VoIP) to connect to the audio conference (Mac)

1. In the Audio pane of your Control Panel, select the **Mic & Speakers** option to connect to the audio conference over VoIP (requires microphone and speakers).

2. Test your audio hardware and audio input and output. The audio indicators should turn green when you or other attendees speak.

If your microphone or speakers aren't working, try selecting another device that's connected to your computer until the audio indicators turn green.

   - If your microphone is not working, change your audio input device from the drop-down menu. Try talking into the microphone to test if the audio is picked up.
   - If your speakers are not working, change the audio output device from the drop-down menu. Listen to see if you can hear audio.

3. You may adjust the speaker volume on your Mac if needed.
Test your audio setup (Windows only)

Test your audio setup by clicking Settings in the Audio pane of your Control Panel. Or, you can right-click the GoToWebinar daisy icon in your system tray, and select Preferences > Audio. Check to see if you’re using an appropriate audio device. Click Play Sound to check that you can hear sound from your speakers. Speak into the microphone to test your microphone setup.

Edit audio mode (organizer only)

As the organizer, you can edit the audio mode in-session if you’d like to provide additional audio options for your attendees.

1. In the Audio pane of your Control Panel, click Edit on a Windows computer. On a Mac, click the Edit Audio Options drop-down icon.
2. Select Edit Audio Mode from the drop-down menu.
3. In the Edit Audio Mode window, change your audio options. You can only select either Use built-in audio conferencing or Provide your own conference call information – but not both.

- Use built-in audio conferencing
  - Provide VoIP only (requires microphone and speakers)
  - Provide a conference call number only
  - Provide both

- Provide your own conference call information
  - Organizers
  - Panelists
  - Attendees

4. Click OK to save your changes.
**Play or disable on-hold beeps (organizers only)**

1. In the Audio pane of your Control Panel, click **Edit** on a Windows computer. On a Mac, click the Edit Audio Options drop-down icon ➔.

2. Select **Play On-Hold Beeps** from the drop-down menu. If there's a checkmark next to it, then everyone will hear beeps while on-hold. If no checkmark appears next to it, no one will hear any on-hold beeps.

**Play or disable entry or exit chimes (organizers only)**

1. In the Audio pane of your Control Panel, click **Edit** on a Windows computer. On a Mac, click the Edit Audio Options drop-down icon ➔.

2. Select **Play Entry/Exit Chimes** from the drop-down menu. If there's a checkmark next to it, then everyone will hear chimes when someone enters or exits the session. If no checkmark appears next to it, no one will hear entry or exit chimes.

**Use the Sound Check Wizard**

You can check your speakers and microphone by using the Sound Check Wizard in the Audio pane of your Control Panel.

1. Click **Sound Check** in the Audio pane.

2. The Sound Check Wizard will open on the Microphone pane.

   - To test your microphone, select the different available microphones and then speak. The microphone that shows the most green bars is the one that will have the best audio quality during the meeting.
• To test your speakers, select the different available speakers and click the Play button. The speakers that show the most green bars are the ones that will have the best audio quality during the meeting.
Co-Organizers

If you're the scheduling organizer, you can make someone a co-organizer so that another participant can present and control the session like you. Attendees and panelist can be promoted to organizers in-session but won't have access to post-session features, such as reporting, archiving recordings and sending follow-up emails. Panelists can speak and present during the session and answer assigned questions, but the organizer first has to give a panelist the presenter role before they can present.

Add a panelist before a session starts

1. **Log in** to your GoToWebinar account.
2. Select **My Webinars** from the left navigation to choose your scheduled session.
3. On the Manage Webinar page, select **Edit** next to Panelists.
4. Enter the person's name and email address.
5. To add another panelist, click **Add Another Panelist**.
6. When you're done, click **Save**. You can view your panelists on the Manage Webinar page. Your panelists will receive an invitation email with a link to join the session.
Add a panelist in-session

1. To make someone a panelist during a session, right-click their name from the Attendee List and select **Make Panelist**.

2. When you're prompted to make them a panelist, click **Yes**.

3. If you want a panelist to show their screen, right-click their name from the Attendee List and select **Make Presenter**. You can also select the **Change Presenter** button from the Screen Sharing pane to choose their name.
Make someone a co-organizer before a session

You can make someone a co-organizer before the session begins so they can start the webinar if you are unable to.

1. Go to the My Webinars page and select the webinar you would like to add a co-organizer to.
2. On the Manage Webinar page, click Edit next to co-organizers.
3. Search for a user on your account by entering their first name, last name or email address.

4. Once you have selected the user you would like to add to the meeting, click **Save**.

5. To share the meeting invitation with the co-organizer, click **Share** or forward the Calendar invite. The co-organizer can now start the meeting by clicking the Webinar Invitation URL.

**Make someone an organizer in-session**

1. During a session, right-click a participant's name from the Attendee List.

2. Select **Make Organizer**. Once you make someone an organizer, they have the same abilities as you do for the remainder of the session.
Screen Sharing

Screen Sharing allows you to present a document, presentation or whatever you want to share with your attendees. If you have multiple monitors set up, you can choose to share all monitors or single monitors. If you have multiple applications running on Windows, you can choose to share only one program, application, monitor or window. You can also show a clean Windows desktop to hide icons and the task bar, as well as blank out the background, so that the focus remains on the content you are presenting to your attendees.

Start Screen Sharing

1. To begin speaking to the entire audience, click Start Broadcast. Otherwise, only staff members will be able to hear you. When you're ready to start sharing your screen, click the Show My Screen button in the Screen Sharing pane.

2. Use the Screen drop-down menu to choose what you want to share. By default, your main monitor is displayed. If you're on a Windows computer, you can also choose to show specific applications and a clean screen.

   Note: Sharing specific applications or a clean screen is not currently available on Mac, so we recommend closing any windows you don't want attendees to see before you start sharing your desktop.

Pause Screen Sharing

1. If you want to temporarily pause Screen Sharing, click the Show My Screen button again. Your screen remains frozen on the last image attendees see until you re-start Screen Sharing.

2. To resume Screen Sharing, click the Show My Screen button.
Stop Screen Sharing

1. If you want to stop showing your screen to attendees, click the **Stop Showing Screen** button in the Screen Sharing pane to disable it. Attendees see the GoToWebinar Viewer when you stop sharing your screen.

   - **To resume Screen Sharing**, click the **Show My Screen** button.
   - **To leave the session without ending it for everyone else**, click **File > Exit - Leave Webinar**. You need to make someone an organizer to hold the session in your absence.
   - **To end the session for everyone**, click **File > Exit - End Webinar** or simply click the Quit icon at the top-right corner of your Control Panel.

HDFaces Video Conferencing

GoToWebinar with HDFaces is a high-definition video conferencing technology that combines screen sharing, audio conferencing and video conferencing. Organizers and panelists can share up to 6-high resolution video conferencing streams in a webinar. A resizable viewer and customizable layouts allow you to adapt to numerous monitor and projection configurations. All you need is an Internet connection and a webcam to begin enjoying a telepresence-quality experience!

Share or stop webcams from the Control Panel

You and your attendees can share webcams in any of the following ways:

- Click the Webcam icon on the Grab Tab.
- Click the **Share My Webcam** button in the Webcam pane on the Control Panel.
- Select **Share My Webcam** from the Webcams drop-down menu.
- Click the Webcam icon next to your name in the Attendee List (Windows only).
- Right-click your own name in the Attendee List, and select **Share My Webcam**.
Organizers can send webcam requests to attendees in any of the following ways:

- Click the Webcam column on the Attendee List.
- Right-click an attendee’s name from the Attendee List, and select **Send Webcam Request** from the drop-down menu.

Organizers can turn off attendee webcams in any of the following ways:

- Click the Webcam icon next to an attendee’s name. Attendees will see a yellow tool tip or dialog indicating that the organizer has closed their webcam feed.
- Right-click an attendee’s name from the Attendee list, and select **Stop Webcam Sharing**.
Manage your webcam from your video feed

- Temporarily Pause/Play your video by selecting the Pause icon or Play icon on the top-right corner of your webcam feed. (a)
- Resize the webcam Viewer and Screen Sharing using the slider. You can click and drag any part of the slider to adjust the display. (b)
- When only webcams are being shared, participants can resize webcams by clicking and dragging the bottom-right corner of the Viewer. Expand and minimize how webcams and/or screen sharing is displayed by clicking and dragging the bottom-right corner of the Viewer.
  - If only webcams are being shared, you can adjust the size and position of the webcam Viewer from the Webcams drop-down menu by selecting one of the following Webcam Positions:
    - Top
    - Left
    - Bottom
    - Right
Toggle the webcam layouts

Attendees can change the webcam position from the Webcams drop-down menu located in the top-left corner of the viewer or the Webcam pane in the Control Panel (only available when both webcams and Screen Sharing are enabled).

- **Share My Webcam** - Shares your own webcam.
- **Stop Sharing My Webcam** - Stops broadcasting your own webcam.
- **Hide Webcams** - Hides the webcam viewer but still broadcasts your webcam feed to other attendees.
- **Always in Front** - Keeps webcams on top of all other applications and windows (only available for Windows organizers and all Mac participants). Hiding webcams decrease bandwidth consumption.

Remove webcams for all participants

From the Options menu, organizers can uncheck the **Attendees Can Share Webcams** setting to remove the option for all participants to share webcams.
Manage your webcam settings

1. Open the **File menu > Preferences > Webcam**. Or, right-click the GoToMeeting daisy icon from your system tray, and select **Preferences > Webcam**.

2. From your Webcam Preferences, you can view the following:
   - **Your camera** – Shows the make and model of your detected webcam.
   - **Select a display format** – Adjusts the aspect ratios of webcam feeds. 4:3 is the normal display and 16:9 is the widescreen display.
   - **Advanced** – Modifies your hardware settings from within GoToMeeting. Customizable options depend on your webcam manufacturer.
Recording

You can record a session and store the recording for attendees to view at a later time. The presenter's screen, the audio and shared applications are recorded. By default, recording is enabled, but if you previously disabled it, you must first adjust your recording settings before you can record a session.

Enable recording from your settings

1. On a Windows computer, right-click the GoToWebinar daisy icon and select Preferences. On a Mac, open GoToMeeting, click the GoToMeeting menu and select Preferences.
2. Select Recording in the left navigation.
3. In the Audio section, choose the audio format:
   • Don't record audio: Records the presenter's screen only.
   • Use GoToWebinar audio service: Records everyone who speaks via VoIP or telephone.
   • Use your own audio service: Requires a physical input device. A mic can record your voice only. A phone patch can record everyone who speaks.
4. In the Video section, choose the recording media format:
   • Record in GoToMeeting format: Requires no processing or conversion time. Viewable in Windows Media Player 9 or newer. If someone doesn't have GoToWebinar installed, they must install the GoToMeeting codec before they can view the recording.
   • Convert to Windows Media Player file: Requires additional processing time after you stop the recording, but anyone can view it using Windows Media Player 9 or newer. Your recording file automatically begins converting after the sessions ends.
5. Browse to a location on your computer where you want to save the recording - a location on your hard drive is best. Click Save. If you don't choose a recording location before the session begins, the default location is the My Documents folder.
6. In the Preferences window, click OK.
Start recording a session

**Note:** We recommend having 2 organizers record the session in case 1 organizer encounters any issues that may potentially disrupt the recording.

1. In the Screen Sharing pane of your Control Panel, click **Start Recording**.

![Start Recording](image1)

2. The free storage space available in the saved recording file location is displayed next to the button.

At least 500MB of free space must be available to record a session in GoToMeeting format, and at least 1GB of free storage space for Windows Media Player and .MOV format. If the recording space drops below 100MB, the recording automatically stops.

Everyone in-session will see a notification that the session is being recorded at the bottom of the Control Panel.

![Notification](image2)

Stop recording a session

1. In the Screen Sharing pane of your Control Panel, click **Stop Recording** to temporarily pause or stop recording altogether.

2. The recording may take some time to process and convert, depending on which recording media format you chose. If you didn't choose a location to save your recording to before the session started, the recording file is located in the *My Documents* folder.

![Stop Recording](image3)
**GoToMeeting Recording Manager (Mac)**

If you record a session on a Mac, you must first convert the recording file to an .MOV file before anyone can view it. Using the GoToMeeting Recording Manager, you can easily convert multiple recordings at once either immediately after you end a session or whenever it's convenient for you.

Recording sessions on Macs is only available if you're running Mac OS X 10.6 (Snow Leopard) or higher. If you're a Mac organizer using GoToMeeting v5.2, your recordings will be saved as .MP4 files. To both upload and stream .MOV files to the GoToWebinar website, you must use Mac OS X 10.7 (Lion).

**Convert Your Mac Recordings**

1. After you end a session on a Mac, the GoToMeeting Recording Manager automatically launches and prompts you to convert your recording (if you haven't changed your default settings). You can choose **Not Now** or **Convert Recording**.

![](image)

2. If you click **Not Now**, you can launch the Recording Manager later from **Preferences - GoToMeeting** > **Convert Recordings Now**. To convert your recording immediately, click **Convert Recording** to launch the GoToMeeting Recording Manager.

If you have older recordings you need to convert as well, expand the "Recordings You Need To Convert" option to see a list of all your recordings that need to be converted.

3. Choose the recording(s) you need to convert by selecting the check box next to the recording. Then click **Convert Recordings**.
The conversion process may take some time depending on the size of your recording. If you want to delete a recording without converting it, click the Trash Can icon next to a recording.
4. After the conversion process is completed, you can share the .MOV file via email, YouTube, Vimeo, etc., and anyone can view it. In the Recording Manager, either click the Magnifying Glass icon next to a converted recording or click Open Recordings Folder to open the location where your converted recordings are stored. By default recordings are stored in /Users/<current user>/Documents/Recordings. To change where recordings are saved, open Preferences - GoToMeeting > Recordings > Choose to browse for a new location.

**Give Keyboard and Mouse Control**

If you're a presenter, you can give keyboard and mouse control to an organizer, panelist or attendee so they can control your screen. You can always override the attendee by moving your mouse to re-gain control. Making an attendee a presenter automatically makes the attendee a panelist until the end of the session.

**Give keyboard and mouse control to another organizer or panelist**

1. In the Screen Sharing pane of the Control Panel, click the Give Keyboard & Mouse button.
2. Select an organizer or panelist's name from the drop-down menu. Or, you can right-click their name from the Attendee List and select **Give Keyboard & Mouse**.

3. When prompted to confirm that you'd like to give them control of your keyboard and mouse, click **Yes**.

4. Once the organizer or panelist accepts control, they can control your screen.
   - **To take back keyboard and mouse controls**, click the **Give Keyboard & Mouse** button, and select your own name.
   - **To temporarily take control of your keyboard and mouse**, simply move your mouse or begin typing to override the other person's control over your screen.

**Give keyboard and mouse control to an attendee**

1. From the Attendee List, right-click an attendee's name.

2. Select **Give Keyboard & Mouse** from the drop-down menu. Once you give keyboard and mouse control to an attendee, they automatically become a panelist for the remainder of the session.

3. When prompted to confirm that you'd like to give them control of your keyboard and mouse, click **Yes**. Once they accept control, they can begin controlling your screen.

**Take back keyboard and mouse control**

1. In the Screen Sharing pane of the Control Panel, click the **Give Keyboard & Mouse** button.

2. Select your own name from the drop-down menu.

3. When prompted to confirm that you'd like to take back keyboard and mouse control, click **Yes**.

**Temporarily take control of your keyboard and mouse**

1. Simply type or move your mouse to re-gain control temporarily. The other person can continue to control your keyboard and mouse, but you will override their movements.

2. Instruct the person with keyboard and mouse control to resume controlling your screen when you're finished.
Change Presenter

During a session, you can change presenters so that someone else can show their screen.

Make someone a presenter in-session

1. Right-click an attendee's name from the Attendee List.
2. Select Make Presenter. Or, use the Change Presenter button in the Screen Sharing pane to choose the attendee you want to make a presenter.
3. When prompted to make them a presenter, click Yes. Once you make someone a presenter, you are no longer the presenter.
4. The attendee will see a dialog saying that they've been made the presenter. When they're ready, they can click Show My Screen to start sharing content.

Take back presenter control

1. If you made someone a presenter, you can take back presenter control by using the Change Presenter button in the Screen Sharing pane to choose your own name.
2. When you're ready, click Show My Screen to start Screen Sharing.
Drawing Tools

If you're presenting during the session from a Windows computer, you can use drawing tools to annotate directly on your screen to highlight, call out and draw attention to your document, presentation or whatever you're sharing. You can also engage other presenters or organizers by allowing them to draw on the screen.

Draw on-screen

1. During a session, click the Drawing Tools menu icon from the Grab Tab.
2. Select a drawing tool.

Allow another organizer or panelist to draw

1. Right-click a participant's name from the Attendee List.
2. Select Allow Drawing. The participant now has a Drawing Tools icon next to their name in the Attendee List. They can access the drawing tools from their Grab Tab.

Erase all markings

1. If you're the presenter, click the Drawing Tools menu icon from the Grab Tab.
2. Select Erase all drawings.

Disable drawing tools

1. If you're the presenter, click the Drawing Tools menu icon from the Grab Tab.
2. Select Normal non-drawing mode to disable drawing tools for everyone.
Dashboard

The Dashboard allows you to monitor the session at-a-glance. You can quickly view the timer (duration of the session), attendance, audience attentiveness, questions and raised hands.

Monitor the Dashboard

- **Timer**: Begins when the presenter starts sharing their screen. The duration of the session is based on the scheduled start and end times.
- **Attendance**: Shows the number of session participants in-session.
- **Attentive**: Displays the percentage of session participants who have the GoToWebinar Viewer on top of all other applications in comparison to those who have the GoToWebinar Viewer in the background.
- **Questions**: Shows the number of attendee questions waiting for a response. Clicking the number opens the Questions pane where you can read and respond to open questions.
- **Polls Given**: Displays the number of Polls that already have been launched and closed over the total number of Polls waiting to get launched for the session.
- **Hands Raised**: Shows the number and percentage of session participants who've raised their hands. Clicking the number opens the Attendee List where you can see who has raised their hand.
**Audience View**

The Audience View displays a thumbnail view of what attendees see when you share your screen. You can literally see what your attendees are seeing by looking at the Audience View pane.

**Note**: Audience view is not currently available for Mac users.

**View what your audience see**

- **Audience View**: Allows presenters to view a thumbnail image of what everyone else in the session is seeing.
- **Attentive**: Displays the percentage of participants who have the GoToWebinar Viewer on top of all other applications in comparison to those who have the GoToWebinar Viewer in the background.
Attendee List

The Attendee List displays all the participants in-session. You can right-click names, columns or icons to manage your session. You can toggle between the Attendees tab and the Staff tab to see who's in attendance.

View and manage the Attendee List

- **Attendee List:** Displays everyone that can view the presenter's screen but is initially muted on the conference call. You can also make an attendee a panelists so that they may speak during the session.
- **Staff List (Windows only):** Displays the names of organizers, presenters and panelists.

Polls

You can use Polls to engage your attendees and focus their attention on the session. You can create Polls before the session starts or during the session on-the-fly. After you close a Poll, you can choose to show the results to your attendees immediately or later. Shared results display total attendee responses and don’t include any individual information. You can view attendees' responses after the session by creating an Attendee Report.

Launch and close a Poll

1. In the Polls pane, scroll to the Poll you want to launch. Click the **Launch** button so that attendees see the Poll in their Viewer.
2. After you've given attendees time to respond, click the **Close** button to close the Poll.

Show Poll results

1. In the Polls pane, find the Poll you want to share with your attendees.
2. Click the **Share** button.
3. To resume presenting, click **Hide**.
Create or edit Polls in-session

1. Expand the Polls pane in your Control Panel. If you're presenting, first pause or stop Screen Sharing.

2. Click **Manage Polls**. Log in to your account if prompted – you'll be taken to the Manage Polls page where you can create new Polls.

3. After editing your Poll, click **Save**. You may need to log out of your account to see the new or updated Polls in the Polls pane.

4. Return to the session, and select a Poll from the drop-down menu. Click **Launch**. Screen Sharing will be temporarily paused while the Poll is in-progress.

5. Click **Close** when everyone has voted. To show the results to everyone, click **Share**. Then click **Hide** to resume the webinar.
Question and Answer

Before a session begins, you can create Questions to engage your attendees in-session. Attendees can ask Questions to organizers during a session. You can sort the Questions and flag them with priority. You can also assign Questions to another organizer or panelist. Only organizers can view all Questions and Answers, set priority and assign Questions to other organizers or panelists. Panelists can only see Questions assigned to them.

Answer your attendees’ Questions

1. In the Questions pane on the Control Panel, select the Question you’d like to answer.

2. Type your response in the text field, or use the drop-down menu to respond, and click Send Privately to send the answer to the attendee only or Send to All to send the answer to everyone in the session.

3. After you’ve answered a question, a checkmark will appear in the flag column.

Assign an attendee’s Question to another organizer or panelist

1. In the Questions pane on the Control Panel, select the Question to highlight the entire row.

2. Right-click the actual Question, and select Assign Question to in the drop-down menu.

3. Choose the name of the organizer or panelist. Whoever you choose will get assigned to the Question.
Enable or disable Question and Answer

1. On the top of the Control Panel, click **Options**.
2. Select **Attendees Can Ask Questions**. If the option is checked, attendees can ask Questions. If the option is unchecked, Q & A is disabled, and no one can ask Questions.

**Labs Menu**

The labs menu in your Control Panel allows you to enable exciting, new beta features that can be used to enhance your session! When you use a lab feature, you are agreeing to use a feature that has not been fully tested and may still have some bugs. If you decide you no longer want to use a lab feature, you can always disable the feature from your Control Panel.

**Enable Lab Features**

1. Click **File** in your Control Panel.
2. Select **Labs**.
3. If you are using labs for the first time, you must select **Agree** on the Labs dialog box.

4. You will then see the available lab features under **File** in your Control Panel. Select a feature to enable it, and a check mark will appear next to it. Select it again to disable it.
Available Lab Features:

- **Video Sharing** - If you select the Video Sharing option, presenters on Windows will see a Share a Video button in their Webcam pane. Presenters can share .wmv, .asf, .avi, .move and .mp4 files. Screen sharing and webcams will be paused while you are video sharing, and videos shared during a session will not be captured in a recording. You can not share a video directly out of PowerPoint or the web.

- **Profile Pictures** - If you select the Profile Pictures option, presenters on Mac and Windows can assign themselves a profile picture by dragging and dropping an image file onto the Attendee pane. Attendees will not be able to assign themselves pictures, but they will be able to see presenter(s)' profile pictures.

- **Allow Sharing a Rectangle** - If you select the Allow Sharing a Rectangle option, presenters on Windows can share a specific, rectangular portion of their screen (rather than their entire screen) by going to the Screen Sharing pane, clicking the Show My Screen drop-down menu and selecting Rectangle.
• Presenters can move the rectangle anywhere on the screen and resize it to fit certain sections that they want to share. In order to see other rectangle sharing options, presenters can right-click the rectangle frame.

• Show Control Panel to Attendees - If you select the Show Control Panel to Attendees option, presenters on Windows can show their Control Panel to attendees while screen sharing if they wish to demonstrate how to use or navigate the Control Panel (typically, the Control Panel is invisible to attendees). Presenters must remember to turn this feature off when they are done instructing so as to not confuse attendees.
Chat

Organizers and panelists can chat with each other to instantly send and receive private messages in-session. Organizers can also send a Chat to the entire audience. Organizers can save a Chat log after the session ends to review messages later.

Chat with another organizer or panelist

1. From the Chat pane in the Control Panel, choose an organizer or presenter's name using the To drop-down menu. Or, from the Staff tab in the Attendee List, right-click an organizer or panelist's name.
2. Enter a message in the provided field, and click Send.

Send a Chat to everyone

1. In the Chat pane of the Control Panel, use the To drop-down menu, and select All.
2. Enter a Chat in the provided field, and click Send. The message will appear in attendees' Question panes.

Save a Chat log

1. On the top of the Control Panel, click File > Save Chat Log.
2. Then browse for a location on your computer to save the Chat log.
3. Click Save. Your Chat log will be saved to the location you choose.
Desktop Notifications (Windows)

Desktop Notifications is a free GoToWebinar feature for Windows users designed to deliver simple and effortless access to complimentary Citrix software upgrades, information, news and discounts you may be eligible for. Desktop Notifications delivers information right to your desktop, allowing you to safely receive important product information that is relevant to you. Desktop Notifications are sent only by Citrix as a service to our customers.

Show desktop notifications

Occasionally, when you are connected to the Internet, Desktop Notifications will automatically connect with Citrix servers to see if there are any new messages for you. If there are any messages for you, Desktop Notifications will display them on your computer screen.

Disable desktop notifications

1. To disable desktop notifications, unselect the “Show me desktop notifications” check box the next time a notification appears.

2. You should no longer receive notifications on your desktop.
Leave and End a Session

You can leave or end a session anytime during the session – even before the scheduled end time. You have the option to leave a session without ending it for everyone else in-session so that everyone else can continue with the session.

Leave a session without ending the session for everyone

1. While in-session, make sure there’s another organizer before you leave the session. If there isn’t another organizer, right-click someone’s name from the Attendee List, and select Make Organizer. Wait until the person has accepted organizer control before leaving.

2. From the Control Panel, click the Quit icon \(\times\) on the top-right corner. When prompted to leave or end the session, click Leave the Webinar. Or, you can click File > Leave Webinar to exit a session.

End a session for everyone

1. On the top-right corner of your Control Panel, click the Quit icon \(\times\). Or, you can click File > Leave Webinar to exit a session.

2. When prompted to end the session for everyone, click Yes.
Reports and History

Registration Report

The Registration Report shows details about your registrants, including the registration date and time, as well as registrant data. Use Registrant Reports to track the registration process for an upcoming session.

The Registration Report may include the following data (depending on any customizations you have in the registration form):

<table>
<thead>
<tr>
<th>Date Range</th>
<th>Last Name</th>
<th>Custom Questions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webinar Title</td>
<td>Email Address</td>
<td>Address</td>
</tr>
<tr>
<td>Webinar Date</td>
<td>Approval Status</td>
<td>City</td>
</tr>
<tr>
<td>Scheduled Start Time</td>
<td>Phone</td>
<td>State/Province</td>
</tr>
<tr>
<td>Scheduled Duration</td>
<td>Organization</td>
<td>ZIP/Postal</td>
</tr>
<tr>
<td>Registered</td>
<td>Organization Job Title</td>
<td>Country</td>
</tr>
<tr>
<td>First Name</td>
<td>Questions and Comments</td>
<td>Industry</td>
</tr>
<tr>
<td>Purchasing Time Frame</td>
<td>Role in Purchase Process</td>
<td>No. of Employees</td>
</tr>
</tbody>
</table>

Generate a Registration Report from the Generate Reports page

1. Log in to your GoToWebinar account.
2. Select Generate Reports in the left navigation.
3. Select the report type:
   - Registration Report – Shows when each person registered for the training and their answers to the registration questions.
   - Attendee Report – Shows details about each attendee, including registration information and how long they attended the session.
   - Performance Report – Shows high-level statistics on the session.
   - Survey Report – Shows a session’s Survey questions and attendee’s answers.
   - Recorded Webinar Report – Shows details about viewers and when the recording was downloaded.
4. Choose a date range within the last year, or choose specific From and To dates to filter your report data.
5. Click Show Webinars to see the results.
6. To export the data, click Generate Excel Report.
Generate a Registration Report from the Registrants page

1. **Log in** to your GoToWebinar account.
2. Select **My Webinars** in the left navigation.
3. Click the title of a session to go to the Manage Webinar page.
4. In the Registrant Management section, click **Manage**.
5. On the Registrants page, click **Registration Report** to export registration data to Excel.
Attendee Report

The Attendee Report shows details about attendees, including registration, Q & A responses, in-session time and interest rating. Use Attendee Reports to follow up with interested attendees after a session. Any custom registration questions you added to the registration form will appear in the report.

The Attendee Report may include the following data (depending on any customizations you've added):

<table>
<thead>
<tr>
<th>Date Range</th>
<th>Attended</th>
<th>Custom Questions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webinar ID</td>
<td>Address</td>
<td>Registration Date</td>
</tr>
<tr>
<td>Webinar Title</td>
<td>City</td>
<td>Question and Answer</td>
</tr>
<tr>
<td>Webinar Date</td>
<td>State/Province</td>
<td>Poll Question</td>
</tr>
<tr>
<td>Actual Duration</td>
<td>ZIP/Postal</td>
<td>Interest Rating</td>
</tr>
<tr>
<td>Total Attended</td>
<td>Organization</td>
<td>In-Session Time</td>
</tr>
<tr>
<td>Name</td>
<td>Job Title</td>
<td>Duration In-Session</td>
</tr>
<tr>
<td>Email Address</td>
<td>Questions and Comments</td>
<td>Survey Question</td>
</tr>
<tr>
<td>Country</td>
<td>Phone</td>
<td></td>
</tr>
</tbody>
</table>

Generate a Report

1. **Log in** to your GoToWebinar account.

2. Select **Generate Reports** in the left navigation.

3. Select the report type:

   - **Registration Report** – Shows when each person registered for the training and their answers to the registration questions.
   - **Attendee Report** – Shows details about each attendee, including registration information and how long they attended the session.
   - **Performance Report** – Shows high-level statistics on the session.
   - **Survey Report** – Shows a session’s Survey questions and attendee’s answers.
   - **Recorded Webinar Report** – Shows details about viewers and when the recording was downloaded.

4. Choose a date range within the last year, or choose specific From and To dates to filter your report data.

5. Click **Show Webinars** to see the results.

6. To export the data, click **Generate Excel Report**.
Performance Report

The Performance Report shows high-level statistics on the session from start to finish, including data on the success of a session.

The Performance Report may include the following data:

<table>
<thead>
<tr>
<th>Date Range</th>
<th>Registered</th>
<th>Number of Surveys Submitted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webinar ID</td>
<td>Attendance Rate</td>
<td>Survey Response Rate (%)</td>
</tr>
<tr>
<td>Webinar Title</td>
<td>Average Attentiveness</td>
<td>Time</td>
</tr>
<tr>
<td>Webinar Date</td>
<td>Average Attendee</td>
<td>Number of Attendees</td>
</tr>
<tr>
<td>Actual Duration</td>
<td>Interest Rating</td>
<td>Percentage of Total Attended (%)</td>
</tr>
<tr>
<td>Total Attended</td>
<td>Question and Answer</td>
<td>Average Attendance Duration</td>
</tr>
<tr>
<td>Polls</td>
<td>Polls Response Rate (%)</td>
<td>Response Rate</td>
</tr>
</tbody>
</table>

Generate a Report

1. Log in to your GoToWebinar account.

2. Select Generate Reports in the left navigation.

3. Select the report type:
   - Registration Report – Shows when each person registered for the training and their answers to the registration questions.
   - Attendee Report – Shows details about each attendee, including registration information and how long they attended the session.
   - Performance Report – Shows high-level statistics on the session.
   - Survey Report – Shows a session’s Survey questions and attendee’s answers.
   - Recorded Webinar Report – Shows details about viewers and when the recording was downloaded.

3. Choose a date range within the last year, or choose specific From and To dates to filter your report data.

4. Click Show Webinars to see the results.

5. To export the data, click Generate Excel Report.
Generate Reports

Step 1: Select Report Type
- **Registration Report**: Shows current registrations.
- **Attendee**: Shows current attendees.
- **Performance**: Shows performance data for the webinar.
- **Survey**: Shows survey questions and attendee's answers.

Step 2: Choose
- **Within**:
  - Yesterday
  - Last 7 Days
  - Last 30 Days
  - Last 90 Days
  - Last 180 Days
  - Today
  - Tomorrow
  - Next 7 Days
  - Next 30 Days
  - Next 90 Days
  - Next 180 Days
  - Next 365 Days

Step 3: Select Webinar
<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Title</th>
<th>Registrants</th>
</tr>
</thead>
<tbody>
<tr>
<td>May 11, 2012</td>
<td>2:00 PM PDT</td>
<td>Webinar 2</td>
<td>1</td>
</tr>
</tbody>
</table>

Generate Excel Report
**Survey Report**

The Survey Report shows the session's Survey questions and attendee's answers. Use the Survey Report to view your attendee's responses.

The Survey Report may include the following data (depending on any customizations you've added):

<table>
<thead>
<tr>
<th>Report Generated Time</th>
<th>Email Address</th>
<th>Last Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webinar ID</td>
<td>Submitted Date/Time</td>
<td>First Name</td>
</tr>
<tr>
<td>Survey Name</td>
<td>Survey Questions/Responses</td>
<td></td>
</tr>
</tbody>
</table>

**Generate a Report**

1. [Log in](#) to your GoToWebinar account.
2. Select **Generate Reports** in the left navigation.
3. Select the report type:
   - **Registration Report** – Shows when each person registered for the training and their answers to the registration questions.
   - **Attendee Report** – Shows details about each attendee, including registration information and how long they attended the session.
   - **Performance Report** – Shows high-level statistics on the session.
   - **Survey Report** – Shows a session’s Survey questions and attendee’s answers.
   - **Recorded Webinar Report** – Shows details about viewers and when the recording was downloaded.

4. Choose a date range within the last year, or choose specific From and To dates to filter your report data.
5. Click **Show Webinars** to see the results.
6. To export the data, click **Generate Excel Report**.
Generate Reports

Step 1: Select Report Type
- Registration Report: Shows current registration counts.
- Performance Report: Shows how participants engaged with the webinar.
- Survey Report: Shows webinar questions and attendee's answers.

Step 2: Choose
- Within: Next 90 Days
- From: Next 180 Days
- To: mm/dd/yyyy

Step 3: Select Webinar
- May 11, 2012  2:00 PM PDT  Webinar 2  1 Registrants

Generate Excel Report
Recorded Webinar Report

The Recorded Webinar Report shows details about your recording history, including who registered to view recordings and when recordings were viewed. If you choose to attach a recording in a follow-up email, the Recorded Webinar Report will also show which attendees viewed the recording from the follow-up email. Use the Recorded Webinar Report to see past data on recording uploads, views, etc.

The Recorded Webinar Report may include the following data (based on any customizations you’ve added):

<table>
<thead>
<tr>
<th>Date Range</th>
<th>View Time/Date</th>
<th>State/Province</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webinar Date</td>
<td>First/Last Name</td>
<td>ZIP/Postal</td>
</tr>
<tr>
<td>Webinar Title</td>
<td>Email Address</td>
<td>Country</td>
</tr>
<tr>
<td>Recording Upload Date</td>
<td>Organization</td>
<td>Phone</td>
</tr>
<tr>
<td>Total Registered</td>
<td>Address</td>
<td>Custom Questions</td>
</tr>
<tr>
<td>Total Recordings Viewed</td>
<td>City</td>
<td>Questions and Comments</td>
</tr>
</tbody>
</table>

Generate a Report

1. Log in to your GoToWebinar account.
2. Select Generate Reports in the left navigation.
3. Select the report type:
   - Registration Report – Shows when each person registered for the training and their answers to the registration questions.
   - Attendee Report – Shows details about each attendee, including registration information and how long they attended the session.
   - Performance Report – Shows high-level statistics on the session.
   - Survey Report – Shows a session’s Survey questions and attendee’s answers.
   - Recorded Webinar Report – Shows details about viewers and when the recording was downloaded.

3. Choose a date range within the last year, or choose specific From and To dates to filter your report data.
4. Click Show Webinars to see the results.
5. To export the data, click Generate Excel Report.
View Webinar History

You can view webinar history to see information on your past sessions, including the session's date, time, title, duration and attendees. If a session has just ended, it may take up to 15 minutes before it appears in your webinar history. Your webinar history is stored for 90 days after a webinar's scheduled end date.

View past webinar history

1. Log in to your GoToWebinar account.
2. Select Webinar History from the left navigation.
3. On the Webinar History page, sessions you've hosted within the past 90 days are shown.

View attendee details

1. On the Webinar History page, select the number in the Attendees column to view attendee details (i.e., name, email address and join and leave times) for a past session.
2. To export the attendee data to Excel (.XLS), click the Export to Excel button.
FAQs

Join a Session

Review frequently asked questions on joining a session.

Can I attend a GoToWebinar session from an iPad, iPhone, iPod touch or an Android smartphone or tablet?

How do I register and join a session?

When you receive a GoToWebinar email, click the Registration URL to register for the session. You can then join the session at the scheduled time in any of the following ways:

- Click the Join URL in your confirmation or reminder email, which you received when you successfully registered for the session.
- Visit the Join the Webinar page. Type or copy and paste the Webinar ID from your invitation email, and enter your email address. Then click Continue to enter the session.

Do I need a GoToWebinar account to attend a session?

No, you don't need a GoToWebinar account to attend a GoToWebinar session.

What are the system requirements for attending a session?

- Internet connection
- Windows® 8, 7, Vista, 2003 Server or XP
- Mac OS® X 10.6 (Snow Leopard®) or newer
- Internet Explorer® 7.0 or newer
- Mozilla® Firefox® 4.0 or newer
- Safari™ 3.0 or newer
- Google Chrome™

See the full System Requirements for more information.

Can I attend a GoToWebinar session from an iPad, iPhone, iPod touch or an Android smartphone or tablet?

Yes, you can attend sessions on your iPad, iPhone, iPod touch or Android smartphone or tablet as an attendee only. You won't have the ability to share your screen if given presenter control.

Can I view presentations in full-screen mode?

Yes. On the top of the Attendee Control Panel, select the View menu > Full Screen. Or, you can click the View button on the Grab Tab to toggle between Full Screen and Window mode.
Audio Conferencing FAQs

Review frequently asked audio conferencing questions.

Is there a cost for using the integrated audio conferencing feature?

Your plan includes unlimited audio at no extra cost. You can use toll-based phone conferencing or VoIP (requires microphone and speakers) exclusively or allow participants to choose between both options. You can also provide your own conference call number for organizers, panelists and/or attendees, but you won't be able to choose our integrated audio conferencing options if you do so.

If you purchased a plan that provides toll (long distance) numbers, participants who dial in are charged their standard long-distance rate for calling. If you purchase Integrated Toll-Free service, your participants can dial in using a toll-free number, and you'll be charged according to the plan that you select.

You and your attendees can also connect to the audio conference free of charge by choosing the Mic & Speakers (VoIP) option where you can send and receive audio over the Internet at no cost using a microphone and speakers connected to your computer. (A USB headset is recommended.)

Is there a toll-free audio option? How do I sign up?

If you'd like to purchase Integrated Toll-Free audio service provided by Citrix Online Audio so that your participants can dial in by telephone using toll-free numbers, call us at 1 866 962 6492. You can then provide your participants with a toll-free number if you so choose. Over 45 countries are available for toll-free numbers.

With this service, you can give your attendees the option of dialing in using VoIP, toll (long distance) or toll-free audio conferencing without any additional equipment needed.

Can I mute/unmute all attendees at once?

You can mute all attendees at once, but you can't unmute them all at once. You can also individually mute and unmute up to 25 attendees.

Can I mute/unmute individual attendees?

As the organizer, you can easily mute attendees on VoIP by clicking the Microphone icon or Telephone icon next to their name in the Attendee List. You can mute attendees who dial in by phone only if they entered their Audio PIN. Attendees will be able to unmute themselves if they wish to speak.

Can I use my own toll-free phone numbers for all of my sessions?

Yes. As an organizer, you can easily change your default audio options from the Settings page. Simply log in to your account, and select Settings to adjust the audio options for future sessions. To provide your own toll-free numbers, select Use my own conference call service on the Settings page, and enter the conference call info for attendees (and optionally for organizers and panelists). Then click Save to apply the audio settings for all future sessions (new default setting).
What microphone/speaker configuration is recommended for best audio quality using VoIP?

For optimum audio quality, we recommend a USB headset connected to your computer, or USB headphones and standalone microphone connected to your computer. Analog versions are okay, but not ideal. We don’t recommend using a webcam mic.

Can I test the quality of my microphone and speakers setup before a session?

Yes. Just right-click the GoToWebinar daisy icon in your system tray, and select Preferences > Audio to choose the device(s) you want to test.

Where can I go for help with audio problems?

Please see our Audio Help for tips on how to troubleshoot common audio problems.

Can I broadcast my computer's audio?

Although GoToWebinar is designed to broadcast audio over VoIP or telephone, you can also broadcast recorded audio from your computer. Due to some sound card limitations, these instructions may not always work on every system.

Broadcast audio on Windows 7 or Vista

1. Right-click the Speakers icon in the system tray, and select Recording devices.
2. On the Recordings tab, right-click the first item on the list, and select the Show Disabled Devices option.
3. Check that Stereo Mix is the default device, and click OK.

Broadcast audio on Windows XP

1. Double-click the volume icon in the system tray.
2. Select Options > Properties.
3. Below Adjust Volume for, choose Recording.
4. Check that Stereo Mix is enabled, and click OK.
5. On the Recording Control window, select the check box under Stereo Mix.

Broadcast audio using hardware

You will need the following:

- Two 3.5 mm audio splitters (one male, two female)
- One 3.5 mm audio patch cable (two male ends, typically 3" long)

1. Plug one splitter into your line out port (typically green for speakers).
2. Plug the other splitter into your microphone port (typically pink).
3. Plug the patch cable into the splitter on line out and then into the splitter on your microphone.
4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out splitter.
Is there any way to see if there are any unidentified callers in my meeting?

- Yes, internal customer support reps and Account Managers can enable the "Audio Attendee Identification" feature from the User Settings page. Organizers will then be able to see any unidentified callers who have called into the meeting (as well as attendees who have called into the meeting without joining the screen-sharing portion of the meeting) but have not entered their Audio PIN.

Integrated Toll-Free Audio FAQs

Review frequently asked Integrated Toll-Free audio questions.

What is Integrated Toll-Free Audio Service?

Integrated Toll-Free audio service provided by Citrix Online Audio allows you to offer your attendees a toll-free number option. With Integrated Toll-Free, you have the flexibility to schedule your sessions with any combination of toll-based, toll-free and VoIP audio.

How much does it cost to use the Integrated Toll-Free audio service?

Per-minute charges are based on your service contract, and minutes are calculated per participants. For instance, if 3 participants dialing to the session for 10 minutes using the toll-free option, you will have used 30 minutes of your plan. Those who join by regular toll numbers are charged rates based on their own long-distance provider. There are no additional charges for those who join a session using VoIP.

How am I billed for the toll-free service?

You will receive a separate monthly invoice from Citrix Online Audio, LLC for any toll-free minutes used by you and your attendees.

How do I add the toll-free option to sessions that I've already scheduled?

For any sessions that were scheduled prior to enabling toll-free integration, the regular toll-based conference numbers will automatically be changed when toll-free numbers are added to an existing session. It is recommended that you resend the invitation email to participants so they have access to the new toll-free audio information. The Webinar ID and URLs will stay the same, and the new toll-free number will be provided to attendees in the Waiting Room, as well as in the Audio Pane of the Control Panel.

How do I schedule a session with Integrated Toll-Free?

When you're scheduling a session, click Edit countries in the Audio section to choose which toll-free numbers you'd like to provide to attendees.

For which countries do you offer international toll-free & long-distance (toll) service?

See the available international toll-free and long-distance (toll) numbers.
Is there anything different about recording a session with Integrated Toll-Free?

Whether you or your attendees join with VoIP, long distance or toll-free audio, you can seamlessly record audio. Open Preferences > Recording > Use GoToMeeting integrated audio.

How can I cancel Integrated Toll-Free?

If you’d like to cancel your Integrated Toll-Free service, please contact our 24/7 Global Customer Support.

Multi-Seat Admin FAQs

Review frequently asked Multi-Seat Admin questions.

What is a multi-seat admin?

A multi-seat admin is someone that can add up to 39 organizer seats and manage those organizers in the Multi-Seat Admin Center. Multi-seat admins can add more seats online from the My Accounts page until they reach 39 organizer seats. Adding more than 39 seats upgrades the account to a corporate plan and must be done offline by corporate sales.

What are the benefits of a multi-seat plan?

Multi-seat plans offer a lighter version of the corporate plan, letting you purchase and manage up to 39 organizer seats online. You have more features than an individual plan with only 1 organizer seat, and you can manage everything online. You can purchase a monthly or annual plan and cancel at anytime.

How does a multi-seat plan differ from a corporate plan?

Multi-seat plans can be purchased online (unlike corporate plans) and allows you, as the administrator, to select up to 39 organizer seats to manage on your account. You can have multiple organizers schedule and host their own sessions, but you don’t need to worry about all the robust features, like groups and settings, that corporate plans have. You also have access to the Multi-Seat Admin Center where you can add/remove organizers, manage seats and run reports.

Corporate plans have more than 5 organizer seats and pay offline via invoice. Purchasing additional seats is done by contacting sales. With corporate plans, you also have access to a very rich Corporate Admin Center where you can add/remove organizers, manage seats, change individual and default settings, customize and brand your account, as well as run reports.

What can I do in the Multi-Seat Admin Center?

You can add organizers by sending them invites using the standard welcome email template or by creating your own templates and storing them for future use. You can also remove organizers, manage seats and run reports.

How many organizer seats can I purchase?

Multi-seat administrators can purchase up to 39 organizer seats online from the My Account page. If you want more than 39 seats, you’ll need to contact sales to upgrade to a corporate plan.
How can I upgrade my multi-seat account from having only GoToMeeting to having the entire collaboration portfolio?

After logging in, select **My Account** in the top navigation and select **Change Plan**. Choose either the monthly or annual collaboration portfolio plan – you can also change the number of organizer seats by using the drop-down menu. On the Confirm Your Plan page, click **Purchase Now**. Your plan will renew on your billing start date to ensure uninterrupted service. Your credit card on file will be automatically charged, but you may **turn off automatic renewal** whenever you want.

**Host a Webinar FAQs**

Review frequently asked questions on hosting a webinar.

**What can I do with GoToWebinar?**

With GoToWebinar you can easily set up, deliver and monitor large sessions and online events from anywhere at any time with up to 1,000 participants.

- **Registration**: Target and screen your audience with a GoToWebinar registration page branded with your logo. GoToWebinar will manage your registrants for you and send email reminders to them before the session.
- **Presentation**: Attract more audience members by presenting online and reducing travel costs. Engage your attendees with interactive Polls, Surveys and Q & A.
- **Reporting**: GoToWebinar reports track attendance, audience feedback and overall success to help you develop best practices.

**Do I have to be at my computer to host a session?**

You can host a session from a Windows or Mac computer with Internet access.

- **To start a scheduled session**, log in to GoToWebinar. Your scheduled sessions will be listed under My Webinars – just click the **Start** button next to the session you want to start.
- **To host an instant session**, click the **Host a Webinar** button on www.gotowebinar.com, and enter your account email and password. Then click the **Webinar Now** button. Your session will start immediately. To invite people to attend your session, click the **Invite Others** button in the Control Panel to send an invite or instruct attendees to join.
- **To schedule a session**, log in to GoToWebinar, and select **Schedule a Webinar** from the left navigation. Enter a title and description, choose the session type, start date, start time, end time and time zone, and click **Schedule**.

**How do I schedule and set up a session?**

Log in to your account, and select **Schedule a Webinar** from the left navigation. Enter a title and description, choose the session type, start date, start time, end time and time zone, and click **Schedule**. On the Manage Webinar page, you can customize your session with branding, set up and manage registration, schedule follow-up and reminder emails and more.

**How do I start a scheduled session?**

Log in to your account. Your scheduled sessions will be listed under My Webinars – just click the **Start** button next to the session you want to start.
How do I start an impromptu session?

On a Windows computer, you can right-click the GoToWebinar daisy icon 🌼 in the system tray and select Webinar Now to start a session immediately. Once you're in-session, you can click Invite Others to invite other people (Webinar Now sessions can accommodate up to 200 people).

What do I do if my attendees can't hear my voice or see my screen?

Both audio and Screen Sharing need to be turned on once you start a session.

- **To enable audio for your attendees**, press *1 on your telephone, or click the Start Broadcast button at the top of your Control Panel. (The Start Broadcast button appears when using Mic & Speakers and when you enter the Audio PIN while using the telephone.)
- **To enable Screen Sharing**, click Show My Screen in your Control Panel.

If attendees still can't hear your voice or see your screen, test your GoToWebinar connection.

GoToWebinar Roles

Review frequently asked questions on roles in GoToWebinar FAQs.

What is an organizer?

An organizer has a GoToWebinar account and schedules, starts, manages and ends a session. An organizer can also designate other attendees to be organizers or panelists. Once a session starts, the scheduling organizer is the default presenter and may either begin presenting or pass the presenter controls to another organizer or panelist.

What is a panelist?

A panelist is a person who presents and/or answers questions assigned to him or her during a session. A panelist can be given the presenter controls at any time during the session and is able to speak on the conference call by default. Panelists do not need to have GoToWebinar accounts to participate in web events.

What is a presenter?

A presenter is the person who is presenting their screen to the audience. The GoToWebinar organizer is always designated as the initial presenter. The presenter role can then be passed to another organizer, panelist or attendee.

Presenters can show their complete desktops, a clean screen (with no icons or taskbar) or a specific application window to the audience. Presenters may choose to pause Screen Sharing at any time. Presenters may give other organizers or panelists the ability to control their keyboard and mouse.

What is an attendee?

An attendee is someone who can view the presenter's screen but is initially muted on the conference call to minimize background noises that would detract from the presentation. If you're using integrated audio conferencing, the organizer can unmute up to 25 participants (including panelists and other organizers), whether they're using telephone or Mic & Speakers (VoIP). If additional attendees need to speak, a corresponding number of unmuted participants will first need to be muted (only 25 participants may be
unmuted at any time). You can also make an attendee a panelist so that they may speak during the session.

Attendees do not need to have GoToWebinar account to participate in web events.

**How many people can speak on the call at once?**

When using integrated audio conferencing, up to 25 participants can be unmuted and speak on the call at any one time.

**In-Session FAQs**

Review frequently asked in-session questions.

**How can I view what my attendees see during a session?**

When you're presenting on a Windows computer, the Audience View in your Control Panel shows you a thumbnail view of what your attendees see.

**How can I make an attendee the presenter so that they can share their screen?**

During the session, you can right-click an attendee's name in the Attendee List, and select Make Presenter. The attendee now becomes a panelist for the remainder of the session and can share their screen.

**How can panelists view Q & A?**

If you promote a panelist to an organizer role, they can view and manage Q & A from the Control Panel. The panelist now becomes an organizer for the remainder of the session and has full control of the session like you.

**How can my co-organizer launch a Poll for me so that I can participate in the polling?**

Whoever launches the Poll can see the Poll in their own Control Panel and in the attendees' Viewers. If you're presenting, another organizer can launch a Poll so that you can view and respond to the Poll from your Control Panel.

**HDFaces Video Conferencing FAQs**

**How is HDFaces different from other web conferencing video solutions?**

We provide the highest resolution video conferencing quality currently available among web conferencing providers – up to 6 streams at 640p x 480p for a maximum resolution of 1920p x 960p. Best of all, there’s no additional cost to use HDFaces with GoToMeeting!

**What are the system requirements for HDFaces video conferencing?**

- Internet connection with cable modem, DSL or better
- Windows® 8, 7, Vista, XP or 2003 Server, or Mac OS® X 10.6 Snow Leopard® or later
- Dual core 2.4GHz CPU or faster with at least 2 GB of RAM
• Internet Explorer® 7.0 or later, Mozilla® Firefox® 3.0 or later, Google Chrome 5.0 or later or Safari® 3.0 or later
• 700 Kbps or more bandwidth recommended per participant for simultaneous screen sharing, audio and video conferencing

**Which webcams are recommended?**

Video conferencing will work with most standard video conferencing webcams. From our testing, we highly recommend the following webcams:

- Logitech® HD Pro Webcam C910
- Logitech HD Webcam C510
- Logitech HD Webcam C310

**Which webcams are unsupported?**

HDFaces video conferencing does not support the following webcams:

- 4eyeGrab
- Hava Remote Video Device
- Hava Video Device
- BT878 VfW to WDM mapper (32-bit)
- Live! Cam Notebook Pro (VF0400)

**If 6 video streams are being shared and I turn off my video stream, can another participant share their video?**

Yes, panelists and organizers can stop and share video streams at any time. Organizers can also disable a panelist video stream so that another panelist can share their webcam.

**Can I temporarily stop my webcam without giving up my webcam slot?**

Yes. You can pause your webcam temporarily by clicking the Pause button on the top-right corner of your webcam feed.

**Is HDFaces available on GoToWebinar and GoToTraining?**

Yes! HDFaces video conferencing is available for GoToMeeting, GoToWebinar and GoToTraining at no additional cost.

**How do I set up my webcam to use with HDFaces video conferencing?**

Install your webcam using the manufacturer's installation instructions. You can set your webcam settings from GoToWebinarPreferences. We recommend using a headset with mic and speakers (VoIP) instead of your webcam's built-in mic and speakers.

**What happens if I install a webcam during an HDFaces session?**

In most cases, we should be able to detect your new hardware and allow you to use it during the same session.
What are the bandwidth requirements for HDFaces?

We recommend 700Kbps or more per participant for simultaneous screen sharing, audio and video conferencing. HDFaces uses bandwidth optimization to make the best possible use of any available bandwidth. If you experience slow performance issues, try closing data-intensive applications like YouTube, Netflix, Skype, etc.

What is the supported video frame rate?

HDFaces supports up to 30-frames/second. The frame rate depends on your webcam, lighting, network and computer.

Can I join an HDFaces session from an Android or iOS device?

Yes. You can join HDFaces sessions as an attendee, but you'll be unable to view or share webcams and show your screen if you're using an Android device or an iPhone or iPod Touch. If you're on an iPad 2 or newer, you can share and view webcams in meetings. In a webinar, you can only view webcams from an iPad.

What are some video conferencing tips and best practices?

- Secure your webcam on your computer to make sure it's stable and won't move around.
- Choose a location with adequate lighting. If you're sitting directly in front of a window, try moving to another spot; otherwise, your webcam may only capture your silhouette.
- Position your webcam so that your entire face fills up at least half of your webcam viewer.
- For optimal performance, open Preferences > Webcam > Advanced. If you have a high-performance webcam, you can enable high-quality features, such as "face recognition" or "right light," to enhance your video conferencing experience.

How do I select a different webcam if I have more than one plugged in to my computer?

To select a different webcam, open Preferences > Webcam. If more than one webcam is detected, simply choose which webcam you'd like to use from the Your Camera section.

Can I record webcams during an HDFaces session?

Although you can record screen sharing and audio, you cannot record webcams at this time.

Why can't I see other participants' webcams?

Your webcam viewer may be minimized, but you can bring the viewer back up again from your taskbar or dock. If the organizer has unchecked the "Attendees Can Share Webcams" option, you will not be able to share your webcam. If you previously selected the Hide Webcams from the Webcams drop-down menu, select Show Webcams.

Why can't other attendees see my webcam?

Double check to see if your webcam is connected to your computer and then try clicking the Share My Webcam button if you haven't already done so. To see if your webcam has been detected, open Preferences > Webcam.
What should I do if I'm experiencing poor video quality?

Make sure you have adequate lighting in your room. If you have low bandwidth, you should make sure you have nothing else running that might use up bandwidth. If your webcam is out of focus, turn off the auto-focus setting on your webcam. You can also check to see if you're using one of our unsupported webcams.

What should I do if my webcam stops working?

If you have low bandwidth or CPU issues, you may see a "Low Bandwidth" or "Computer Overloaded" message. You'll be prompted to hide all webcams and/or stop sharing your own webcam. If you click Yes, all webcams and/or your own webcam will be hidden.

To improve bandwidth and CPU performance, close all other programs on your computer, and switch to a high-speed cable Internet connection (if you haven't already).

Can attendees share webcams?

No, only organizers and panelists can share webcams. If you want an attendee to share a webcam you may promote them in-session to a panelist or organizer, which will give them the ability to share their webcam.

GoToWebinar Features FAQs

Review frequently asked features questions.

How do I customize my registration page?

On the Manage Webinar page, click Edit in the Registration Setup section to manage registration:

- Add additional registration fields (first name, last name and email address are always required)
- Create your own registration questions
- Set the approval process
- Set up registration notification emails

How do I monitor my attendees during a session?

Using the GoToWebinar Dashboard, you can easily check attendance patterns and monitor attentiveness by viewing the status bars at the top. Green bars indicate 100% session attentiveness, yellow bars indicate mediocre attentiveness and red bars indicate lack of attentiveness. You can also see the number of open questions and hands raised at any time.

What's the difference between Chat and Q & A?

The Chat feature allows organizers to send private messages to panelists or broadcast messages to all attendees. The Q & A feature allows attendees to type and send questions to organizers and panelists who can respond with answers privately or to the entire audience.
How do I save Q & A sessions?
Question and answer sessions are automatically saved and ready for viewing in the Attendee Report 2 hours after the session's scheduled end time.

Can I allow a co-presenter to help me with a session?
Yes. Organizers may invite additional presenters to a session as panelists. During a session, panelists are able to speak to the audience or share content from their own computers.

Can I approve registrants before allowing them to attend?
Yes, you can change your registration settings from automatic approval to manual approval so that you can view all registrants and either approve or deny them before they receive a confirmation email with instructions on how to join the session.

Can I draw on and highlight screen content during a presentation?
Yes. GoToWebinar allows organizers and panelists on Windows computers to use Drawing Tools to highlight and annotate their presentation. These tools include highlighter, pen, spotlight and arrow functions.

Can I conduct Polls and Surveys of my attendees?
Yes. Organizers can create Polls and Surveys before the session begins on the Manage Webinar page. GoToWebinar organizers can also launch on-the-fly Polls during a session and include a Survey immediately after the session or in attendee follow-up emails.

Can I upload PowerPoint® presentations?
With GoToWebinar's screen-sharing technology, there's no need to upload your presentation before your event. Just run it on your desktop and share your screen.

Can I take control of attendee desktops?
Yes, but only if they give you permission. To take control of an attendee's keyboard and mouse, they must be the active presenter.

How do I share one application and nothing else?
A presenter on a Windows computer can share a single application, program, monitor or window by clicking the Show My Screen button on the Control Panel and then selecting which application to share.

Recording and Playback FAQs
Review frequently asked recording and playback questions.
How do I record a session?

On your Control Panel, select View menu > Recording. Click the Settings button in the Recording pane, and confirm that your Audio and Video options are set appropriately. Click OK to save any new settings. Once you're ready to record the session, click the Start Recording button.

To pause or stop recording completely, click Stop Recording. If you click Start Recording again, you'll continue recording to the same file. We recommend having 2 organizers record the session in case 1 organizer encounters any issues that may potentially disrupt the recording. Read more recording tips for useful information on how to record sessions.

What file formats are supported?

If you select the GoToMeeting format (Windows only):

- Recordings are ready for viewing with Windows Media Player 9 or higher, immediately after leaving or ending a session.
- To play a recording, viewers must have GoToWebinar or the G2M2 video codec installed on their computer.
- Mac viewers are unable to view recordings in the GoToMeeting format.
- At least 500MB of disk space is required to record in the GoToMeeting format.

If you select the Windows Media Player format (Windows only):

- Allow time for the conversion to take place. The time needed is dependant on video content, CPU speed and amount of memory available.
- The recording doesn't require viewers to have GoToWebinar or the G2M2 video codec.
- At least 1GB of disk space is required to record in the Windows Media Player format.

If you select the .MOV format (Mac only):

- Recordings are automatically saved as .MOV files using H.264 compression. (If you recorded on GoToMeeting v5.2, your recordings will be saved as .MP4 files instead.)
- Recordings must be converted using the GoToMeeting Recording Manager before anyone can view it.
- After completing the conversion process, anyone can view the recording without additional conversions.
- At least 500MB of disk space is required to record in the .MOV format.

Can people on Macs view recorded sessions on Windows computers?

Yes, but only if the recorded session file has been converted to the Windows Media Player format. The organizer must select the Windows Media Player format setting before recording the session to allow people on Macs to view recordings.

How do I convert recorded sessions to Windows Media Player format?

You must select the Convert to Windows Media Player file option from the Recording Preferences window before the session is recorded.

To access recording preferences, right-click the GoToWebinar daisy icon in your system tray, and then select Preferences > Recording. Or, if you're already in-session, click the File menu on the top of the Control Panel, and then select Preferences > Recording > Convert to Windows Media Player file.

GoToMeeting will then convert the recorded session into a Windows Media Player file after the session is over to avoid slowing down the computer during the session.
How do I record audio? Can I record a session using my own audio service?

If you and your attendees use VoIP or telephone, the audio is automatically recorded.

If you're using your own conference call number, you must have a sound card and an audio input device like a microphone to record audio. If you're recording a teleconference, you can position the microphone next to the phone or set up a phone recording adapter to your phone and line-in input on your computer's sound card.

If you're having trouble with your audio, see Audio Help.

How do I save a recorded session?

Recordings are automatically saved locally to the path indicated in your Recording Preferences when you end or leave a session. Recordings will include the session's subject in the file name. You cannot change the location where you would like to save a recording once you click the Record button. If you can't find your recording, check the path listed in the Recording Preferences. The default location on your computer that recording files are saved to is the My Documents folder, so if you haven't specified a location prior to recording the session, the file should be located there.

Where are my recorded sessions stored?

The default location is in your My Documents folder. You can change the location before you begin recording. We recommend that the location has a minimum of 1GB of free space to accommodate the recording.

How do I play back a session I just recorded?

Replay a session on a Windows computer in the GoToMeeting format or Windows Media Player format:

1. If you haven't already, end the session. GoToWebinar will automatically save your file with the date and time noted after the session title.
2. Navigate to the location where your recording file is saved. The default location is the My Documents folder. You can check the Recording Preferences to see where your file is stored.
3. Click the file name to start the replay.

To view a session recorded in the GoToMeeting format, you must either have GoToWebinar installed or download the GoToMeeting codec. Also, you must wait until the conversion process has finished. GoToWebinar converts the recording into a Windows Media Player file after the session is over to avoid slowing down the computer during the presentation.

Replay a session on a Windows or Mac computer in the .MOV format:

1. After converting the recording using the GoToMeeting Recording Manager, either click the Magnifying Glass icon next to a converted recording or click Open Recordings Folder to open the location where your converted recordings are stored (by default recordings are stored in /Users/<current user>/Documents/Recordings).
2. You can play the recording on a Mac by double-clicking the .MOV file in Finder. You can share the .MOV file via email, YouTube, Vimeo, etc., and anyone on a Windows or Mac can view it.
Can I edit a recorded session?

GoToWebinar Recording allows you to record and preserve sessions as they actually occurred. You may use an editing software, such as TechSmith Camtasia®, to edit those files. Before editing a recording, you must first re-encode it using a tool like Microsoft Expression Encoder.

1. Open Expression Encoder.
2. From the File menu, select Import to find your recording.
3. Select the Encode tab, and expand the Video pane.
4. Configure the settings. We recommend setting the Video Output Format to VC-1 Main and setting Size Mode and Video Aspect Ratio to Source.
5. Select the Output tab, and choose a location for the saved file.
6. From the File menu, select Encode to start the encoding process.

Processing time will depend on the length of recording, output settings and your system hardware. Once re-encoding is completed, you can edit the recording.

Can I email a recorded session?

Depending on the size, session recordings can be zipped and sent by email, sent by FTP or posted on a website. Viewers must have Windows Media Player 9 or higher to view the recording. If the session is sent in the GoToMeeting format, recipients must either have the GoToWebinar software installed or download the GoToMeeting codec.

After you've uploaded a recording to the My Recordings page, you can also attach the recording to follow-up emails by clicking Edit next to Follow-up Email on the Manage Webinar page. Then click Select a Recording under the email template to upload a recording to the follow-up email.

Billing and Cancellation FAQs

Review frequently asked billing and cancellation questions.

How do I change my password?

Log in to your account, and click My Account. Click Edit next to Login Info, and follow the instructions to change and save your new password. Passwords must contain at least 8 characters and include both letters and numbers.

How do I cancel my paid subscription plan?

Log in to your account, and click My Account > Turn Off Renewal. Your service will stop, and you will not be automatically charged. You will lose access to scheduled sessions and reports, but you can log in at any time to buy a plan.

Since GoToWebinar is a pre-paid service, your service will continue until the end of your subscription period. At that time, your plan will be discontinued and will not renew again.

If you're on a corporate plan, contact our Corporate Billing Center.

How do I change my plan or switch products?

You can make changes to your plan online at any time. Log in to your account, and select My Account > Change Plan. Then select a plan and click Purchase Now.

You can also contact Global Customer Support to help you make any necessary adjustments to your account, or call 1 800 263 6317 or direct dial +1 805 617 7000. If you are calling from outside the United
Can I change to a different GoToWebinar attendee tier without affecting my upcoming sessions?

Yes, changing your plan will not affect your previously scheduled sessions. You can always switch to a higher attendee limit prior to your scheduled event.

Log in to your account, and select My Account > Change Plan. Then select a plan and click Purchase Now.

What charges apply when I change my plan?

When you make a change to your plan, your billing will be automatically adjusted and pro-rated against your current account balance. You will receive a confirmation email receipt after the changes are completed.

If your new plan selection increases your subscription price, you will be prompted to enter payment. After submitting payment you will have instant access to the features for the new plan. Your subscription billing date will change to reflect the date of the change in plan.

If your new plan selection decreases your subscription price, a credit will remain on your account, and by default account credit will be applied toward your next scheduled payment. All subsequent subscription billing will reflect the new plan price, and your subscription billing date will change to reflect the date of the change in plan. If you have credit on your account and would like to request a refund, please contact Global Customer Support at 1 800 263 6317 or direct dial +1 805 617 7000. If you are calling from outside the United States, visit Global Customer Support, select your product and click Contact Us for our international numbers.

My account lapsed. How do I reactivate it?

Log in to your account. If your account has lapsed, you should automatically be directed to the Plan Selection page in My Account. If not, select My Account > Change Plan. Then select a plan and click Purchase Now. If prompted, enter updated billing information. Your account will reactivate immediately.

How can I review the charges billed to my account?

You can check your account history by logging in and viewing your recent billing activity at the bottom of the page.

Who do I contact if I have a billing question or if I need to request a refund?

Contact Global Customer Support at 1 800 263 6317 or direct dial +1 805 617 7000. If you are calling from outside the United States, visit Global Customer Support, select your product and click Contact Us for our international numbers.

Will I get a receipt for my purchase?

All of your receipts can be found once you log in and click My Account > View All Activity. You will also receive a receipt via email for your first subscription purchase, subsequent renewals and anytime you change your subscription plan thereafter.
Security FAQs

Review frequently asked billing and cancellation questions.

How secure is GoToWebinar?

Your sessions are completely private and secure. All of our solutions feature end-to-end Secure Sockets Layer (SSL) and 128-bit Advanced Encryption Standard (AES) encryption. No unencrypted information is ever stored on our system.

How do I use GoToWebinar with firewalls?

Our solutions use HTTP outbound connections to transparently enable screen-sharing sessions, even with corporate firewalls in place. In most cases, organizers and attendees can connect to Citrix Online's servers without re-configuring firewall settings.

Can my computer get a virus from downloading the software or attending a session?

No, neither organizers nor attendees can catch or be exposed to viruses from downloading our software. We continuously monitor our development environment for viruses and malware, and all of our downloadable software is digitally signed to prevent tampering by third parties. The warning message customers might see when they install the software is a default message displayed by their browser whenever they download executable files.

Do I need to set my browser to accept cookies to use your website?

You can browse our website without having cookies enabled. However, if you need to log in to an existing account, you will need to adjust your browser's privacy settings to accept cookies. We primarily use cookies to provide you with secure access to your account.

GoToMeeting App for Android FAQs

Review frequently asked questions on GoToMeeting App for Androids.

Can I use the GoToMeeting app for Android to join GoToMeeting and GoToWebinar sessions?

If you're running Android 2.2 (Froyo) or higher, you can install the GoToMeeting app from the Google Play Store to join GoToMeeting and GoToWebinar sessions as an attendee. If you're a GoToMeeting organizer, you can log in and schedule and start a meeting from the app, but you won't yet be able to share your screen, so we recommend making someone else who joined the meeting from a Windows or Mac the presenter or co-organizer.

We recommend using devices with a 1Ghz processor or higher for optimal performance.

How can I download the GoToMeeting app?

You can download the GoToMeeting app from the Google Play Store by logging in to your Google account that's linked with your Android device and searching for the GoToMeeting app. If you don't see an Install button, you may not be running Android 2.2 (Froyo) or higher (the minimum system requirement needed to install the GoToMeeting app).
You can also download the GoToMeeting app from the Amazon Appstore (only available in the U.S.), which lets you instantly download the GoToMeeting app to an Android device.

**What are the minimum system requirements for joining a GoToMeeting or GoToWebinar session from my Android device?**

- Android 2.2 (Froyo) or higher
- 1 Ghz CPU or higher recommended
- WiFi or 3G connection (WiFi and headset recommended)
- Free GoToMeeting App from Google Play or Amazon Appstore

**How do I join a meeting on my calendar from the GoToMeeting app?**

Meetings in the Android Calendar app sync with the GoToMeeting app so you will see a list of your upcoming meetings on your Join screen. You can quickly join a meeting by tapping the name of the meeting.

You will also see a GoToMeeting widget that displays your upcoming meetings. You can tap the meeting to view the meeting information, and tap **Join** to join the meeting.
Can I schedule meetings from the GoToMeeting app?

Yes, you can schedule meetings from the GoToMeeting app by tapping the Schedule a Meeting button. You can then select whether or not is a recurring meeting, choose the audio and edit phone numbers. You can also edit meetings and invite others from the GoToMeeting app.

Can I host GoToMeeting and GoToWebinar sessions on the GoToMeeting app?

You can log in to schedule or start instant or existing meetings from your Android smartphone or tablet, but you won't be able to share your screen. We recommend making someone else who joined the meeting from a Windows or Mac the presenter or co-organizer from the Attendee List. Unfortunately, you can't start GoToWebinar sessions from your Android device at this time.
What are some of the unsupported GoToWebinar features?

Organizers and panelists can’t do the following:

- Host or join a GoToWebinar session
- Join a session from a panelist invitation email
- Present as a panelist or organizer
- Start Screen Sharing

Attendees can’t do the following:

- Start Screen Sharing or accept Presenter Control

Can I record a session from my Android?

No, you cannot currently record sessions from an Android device.

Can I chat from the GoToMeeting app?

Yes, all attendees, organizers and presenters in a meeting can chat by tapping the Chat icon in the toolbar, entering a message and tapping Send. You can choose to chat with everyone in the meeting or privately with another person in the meeting. When you receive a Chat message, the Chat icon will bounce in the keyboard toolbar.

Chat is currently unsupported for GoToWebinar.

Why do I see an “Unable to Join the Meeting” error telling me that the Meeting ID is invalid?

If you manually entered the Meeting ID, double check to see that you typed it correctly.
Why do I have to enable cookies to join? How do I enable cookies on my browser?

If your browser is set to disable cookies, you must first enable cookies before you can join a session. To enable cookies, go to your browser’s settings and select Accept Cookies.

I prefer to dial in to the audio conference by telephone. Where can I find the Audio PIN?

You do not need an Audio PIN to dial in to the audio conference by telephone. To dial in to the audio conference by telephone, you can set your default audio to Phone by going to the Settings tab and selecting the Phone icon next to Default Audio. If your default audio is set to Phone and you join a meeting from an Android device, you will be automatically dialed in to the meeting.

You can see if you are connected to the meeting by VoIP or telephone in the Audio tab. If the organizer has provided dial-in phone numbers, you can switch to telephone by tapping Switch to Phone in the Audio Tab. In the Audio tab, you'll see a list of phone numbers associated with the session. If the organizer provides international country numbers, you can choose which country you want to dial into. Once you tap Dial, you will automatically dial in to the conference from your Phone app and will need to navigate back to the GoToMeeting app to return to the session.

Why am I disconnected from GoToMeeting when I try dialing in from my phone?

If you're using a device that doesn't allow simultaneous data and voice sharing (CDMA), you must connect to the Internet from a WiFi network to dial in using the same device you use to join the session; otherwise, you’ll be disconnected from GoToMeeting. If you aren't connected to the Internet through WiFi, you must use your device’s mic and speakers (VoIP) or dial in with a different device to connect to audio.

GoToMeeting App for iPad, iPhone and iPod Touch

Review frequently asked questions on GoToMeeting App for iOS.

What can I do with GoToMeeting on an iPad, iPhone or iPod Touch?

- Attend online GoToMeeting or GoToWebinar sessions free of charge
- Join sessions in seconds by tapping the Join URL in your invitation email
- View the presenter's screen
- Connect to audio through your iPad, iPhone or iPod Touch's Internet connection or dial in by phone
- Chat with everyone in the meeting, with only organizers or with individual attendees
- See who’s talking and who's attending
- Schedule meetings and invite attendees

What are the system requirements for using the GoToMeeting app for iOS?

- iOS 5 or later
- iPad 1 or newer, iPhone 3G or newer or iPod Touch 3rd generation or newer
- Free GoToMeeting app from the App Store
Are there any additional fees for using the GoToMeeting app?

Nope, the app is free, and there's no charge for attending GoToMeeting or GoToWebinar sessions. But you may be responsible for any long-distance charges associated with dialing into sessions by phone or any data charges that may be incurred.

Can I host a GoToMeeting or GoToWebinar session from my iPad, iPhone or iPod Touch? Can I show my screen if I'm given presenter controls?

Yes, you can log in and host a meeting from an iPad, iPhone and iPod touch with the GoToMeeting app. Organizers can schedule meetings, start previously scheduled meetings and even launch instant meetings from the My Meetings screen. Only iPad presenters can share content on-screen. At this time, you can't host a GoToWebinar session from an iOS device.

Can I schedule meetings from the GoToMeeting app for iOS?

Yes, you can schedule meetings from the GoToMeeting app for iOS. You can invite attendees to these meetings, edit the audio and create a meeting password from the GoToMeeting app. Also, you can delete meetings from the My Meetings screen.

How do I share content as a presenter?

If you're presenting from an iPad, you can share content from the cloud, browser or whiteboard by tapping one of those options from the Tap to Share Content screen. Presenters must first tap the Play icon in the toolbar for attendees to see shared content. The Screen Sharing icon will turn green when content is being shared.
Can I invite others to the meeting?
Yes, organizers can invite others by tapping the Invite icon and selecting either Email, Message or Copy to Clipboard to send the meeting information to others.

As an organizer, can I promote attendees to presenter or organizer?
Organizers can make someone who joins from a Windows, Mac or iPad the presenter so that person can share their screen. At this time, attendees who join from an iPhone an Android cannot be made presenters.

From the Attendee List, organizers can make someone else who joined from a Windows, Mac or Android the organizer. Currently, attendees who join from an iOS device cannot be made an organizer.

Can I see how my screen looks to attendees?
Yes, when sharing content you can preview how attendees are viewing your screen by tapping the Screen Sharing icon and turning Audience View on. A thumbnail image of what attendees are seeing will appear on-screen, which you can hold and drag with 1 finger to move it across the screen.

Can I only draw on a whiteboard?
No, presenters can use Drawing Tools to annotate directly on any screen being shared by tapping the Drawing Tools icon in the toolbar.

Can I join a GoToWebinar session as a panelist?
No, you can't join a session as a panelist on an iPad, iPhone or iPod Touch.

Can I record a session from my iOS device?
No, you can't currently record sessions from an iOS device.

Can I be made presenter during a webinar on an iPad?
No, not at this time.

How does attending a GoToMeeting or GoToWebinar session on an iPad, iPhone or iPod Touch compare with the experience on a Windows or Mac?
Just as on a Windows or Mac, you can view the presenter's screen, see who's attending and who's talking. However, some organizer features are not yet available on the iPad, iPhone and iPod Touch.

Unsupported features for GoToWebinar on iOS:
- Drawing tools
- Presenter controls
- Keyboard and mouse controls
- Start sessions
- Schedule sessions

Unsupported features for GoToMeeting for iOS:
• Keyboard and mouse controls of the presenter's desktop

How can I change the view or zoom into the presenter's screen?

You can view the presenter's screen in both portrait and landscape mode. You can also double-tap anywhere on the GoToMeeting Viewer to change the display to Fill Screen mode. Double-tap a second time to zoom in to 100% mode. Double-tap a third time to return to the default view – Entire Screen mode. You can also pinch or expand with 2 fingers, and pan to different parts of the presenter's screen by dragging 1 finger across the GoToMeeting Viewer.

Can I chat with other meeting participants? Can I ask questions during a webinar?

During a meeting, you can tap Chat in the toolbar to instantly send and receive messages to everyone in the meeting, to only the organizer(s) or to individual attendees. You can toggle between meeting participant names in the Attendee List to read and send messages.

During a webinar, you can tap Questions in the toolbar to send questions to the organizer. You can also view other attendees' questions and answers if the organizer sends the response to everyone in the webinar.

Can I connect to audio from the GoToMeeting app?

If the organizer provides both mic and speakers (VoIP) and conference call numbers as audio options, you'll automatically connect to VoIP over your iPad, iPhone or iPod Touch's Internet connection (WiFi or 3G) once you join. The audio quality depends on the quality and bandwidth available on your WiFi or 3G network (WiFi recommended).

You can dial in by telephone on your iPad, tap the Settings icon > Audio Settings > Telephone to access the conference call information. If you want to dial in on your iPhone, tap the Settings icon > Meeting Information > Phone Number link to automatically connect to audio. With a single tap of a U.S. telephone number, the conference call number, access code and Audio PIN are automatically dialed.

If you have an iPhone 4 or 4S on a network that does not allow simultaneous voice and data sharing (CDMA), you won't be able to connect to GoToMeeting and dial in on your iPhone at the same time. To connect to audio, you should use your iPhone's Internet connection (WiFi or 3G) or dial in with a different device.

Can I mute/unmute attendees using VoIP or dialing in by phone on iOS devices?

Yes, if the attendee is connected to VoIP, you can mute/unmute them to allow them to speak. If the attendee dials in by phone, you can mute/unmute them only if the they have entered the Audio PIN, which they can access in-session from Settings.

Why can't I switch from Telephone to Mic & Speakers (VoIP)?

Once you dial in to the audio conference by telephone, Mic and Speakers (VoIP) becomes disabled for the remainder of the session. If you want to switch back to VoIP, you will need to leave the session and rejoin.
Why can't I connect to GoToMeeting and dial in by telephone on my iPhone?

If you have an iPhone on a network that does not allow simultaneous voice and data sharing (CDMA), you won't be able to connect to GoToMeeting and dial in on your iPhone at the same time. To connect to audio, you should use your iPhone's built-in mic and speakers (VoIP) or dial in with a different device.

If the organizer only provides a conference call number as the audio option and you try to dial in to the audio conference from a CDMA network without having a WiFi connection, you'll see a notification saying that your device does not support simultaneous voice and data sharing. Once you tap the Dial button on the notification, you won't be able to see the presenter's screen.

What audio options does the GoToMeeting app support?

- iPad, iPhone or iPod Touch's built-in mic and speakers (VoIP)
- iPad, iPhone or iPod Touch's built-in mic along with external headphones connected via the 3.5-mm stereo headphone jack
- Headset connected via the 3.5-mm stereo headphone jack
- Bluetooth Hands Free devices

For optimal audio quality, we recommend using a headset.

Can I join HDFaces meetings and webinars from an iPad and view webcams?

Yes, you can join HDFaces meetings and webinars and view webcams from an iPad. You can share your own webcam in a meeting from an iPad 2 or newer, but you cannot yet share your own webcam in a webinar.
Troubleshooting

Audio Help
If you are experiencing difficulty with audio, determine which scenario is applicable to you and follow the recommended guidelines.

I can’t hear anyone
Test your audio setup by clicking Settings in the Audio pane of your Control Panel. Or, you can right-click the GoToWebinar daisy icon in your system tray, and select Preferences > Audio. Check to see if you're using an appropriate audio device. Click Play Sound to check that you can hear sound from your speakers. Speak into the microphone to test your microphone setup.

No one can hear me.
If you're the organizer, you must click Start Broadcast at the top of your Control Panel, or press *1 on your telephone's keypad to start the audio conference.

Check to see that you're not muted by clicking the Audio icon in your Control Panel or Grab Tab.
If you're experiencing problems dialing in by phone, try hanging up and dialing in again.
If you're having problems connecting to VoIP (Mic & Speakers), test your computer's detected audio devices by clicking **Settings** in the Audio pane. Speak into your microphone to test if your microphone setup is working.

**I hear static or clicking sounds.**

Move electronic handheld devices, such as an iPhone, away from your mic and speakers.

**I hear echo, feedback or background noise.**

If you suspect that the echo is coming from an attendee, check to see who's talking at the bottom of the Audio pane in the Control Panel, and mute the attendee by clicking that person's Audio icon.

If you dial in to the audio conference by telephone, make sure that you select **Telephone** from the Audio pane in the Control Panel instead of **Use Mic & Speakers**.

Built-in or external speakers may cause an echo. Try lowering the speaker's volume.

Built-in microphones on your computer or webcam can pick up noise and cause an echo. We don't recommend using built-in microphones. Try plugging in a USB headset to your computer.

**The audio quality is poor and choppy.**

Poor network performance, lack of memory or high CPU usage often causes the audio quality to drop, become delayed or sound robotic.

Try closing all applications you aren't using to free up some bandwidth.

If you're using a dial-up Internet connection with VoIP, it may cause poor performance. For optimum performance when using VoIP, we recommend using a broadband Internet connection.

If the problem persists, switch to Telephone mode. Select **Use Telephone** in the Audio pane and dial in to the audio conference.

**No sound is detected.**

After the first minute of a session, GoToWebinar looks for microphone input from attendees who have the following: a microphone, speaking rights and unmuted.

If no audio input is detected, you may see a "Trying to speak?" pink tip. You may see the error when you haven't spoken or made any sounds when the session starts or if your microphone device is incorrectly selected. Click **Audio Setup** in the Audio pane to test your input device.

**No microphone is detected.**

If a microphone (or headset) isn't detected or connected properly, you may see a pink tip.

Check that your microphone (or headset) is properly plugged in.

If the problem still persists, try switching to Telephone mode if available. Then dial in to the conference using the telephone number and Audio PIN provided in the Audio pane of your Control Panel.

**My microphone is disconnected.**

If your microphone isn't working or gets unplugged during a session, you may see a pink tip.
Check that your microphone is properly plugged in. If the problem still persists, try switching to Telephone mode if available. Then dial in to the conference using the telephone number and Audio PIN provided in the Audio pane of your Control Panel.

**Broadcast Computer Audio**

While GoToMeeting is designed to efficiently broadcast voice audio over telephone or VoIP, there may be times when you wish to broadcast an audio recording from your computer. In this section you will find audio configuration instructions that should allow you to transmit both your voice and audio from your computer. Due to some sound card limitations, these procedures may not work with every system.

**Configure Windows XP to broadcast audio**

*Note:* Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like "What U Hear" on some Soundblaster cards) or may be absent entirely.

*Note:* You cannot use your microphone when switching via software.

1. Double-click the volume icon in the system tray (usually bottom-right of your desktop).
2. Select Options, then Properties.
3. Under Adjust Volume, choose Recording.
4. Ensure "Stereo Mix" is checked.
5. Click OK.
6. On the Recording Control screen, select the check box under Stereo Mix.

**Configure Vista or Windows 7 to broadcast audio**

*Note:* Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like "What U Hear" on some Soundblaster cards) or it may be absent entirely.

*Note:* You cannot use your microphone when switching via software.

1. Right-click the volume icon in the system tray (usually bottom-right of your desktop).
2. Select Recording devices from the menu.
3. Right-click the first item on the list and ensure Show Disabled Devices is checked.
4. Ensure Stereo Mix is the default device.
5. Press OK.

**Hardware option**

**Parts needed:**

- Two (2) 3.5 mm audio splitters (1 male, 2 female).
- One (1) 3.5 mm audio patch cable (2 male ends, typically 3 " long).

**Configure your system to broadcast with hardware**

1. Plug 1 splitter into your line out port (for speakers, typically colored green)
2. Plug the other splitter into your microphone port (typically pink)
3. Plug the patch gable into the splitter on line out and then into the splitter on microphone.

4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out splitter.

**Note:** You may use your microphone and speakers simultaneously.

### Disable the Launcher Plugin

When you download the Citrix Online Launcher file, a browser plugin and the Citrix Online Launcher app will be automatically installed, so that you can connect to future sessions faster. If you frequently join sessions, we don't recommend disabling the plugin or uninstalling the Citrix Online Launcher app (the same way you would uninstall any other program on your computer) because you'll be required to go through the entire manual download process again.

### Disable the Citrix Online Launcher plugin in Firefox on Windows

1. Open Firefox.

2. Select the Firefox menu > Add-ons.

3. In the Add-ons Manager, find the **Citrix Online Web Deployment Plugin**. Click **Disable**.
You can re-enable it again by clicking **Enable**. Please note that each time you download and execute the Citrix Online Launcher file, the add-on will automatically become re-enabled.

**Disable the Citrix Online Launcher plugin in Chrome on Windows**

1. Open Google Chrome, and type `chrome://plugins/` into the address bar.
2. Find the **Citrix Online Web Deployment Plugin**, and click **Disable**.

You can re-enable it again by clicking **Enable**. Please note that each time you download and execute the Citrix Online Launcher file, the add-on will automatically become re-enabled.

**Disable the Citrix Online Launcher plugin in Safari on Macs**

1. Open Finder and select the **Go menu > Go to Folder**. Or, press **Command + Shift + G**.
2. Type `~/Library/Internet Plug-Ins` and click **Go**.
3. Delete the `CitrixOnlineWebDeploymentPlugin.plugin` by dragging it to the Trash on your Dock. You can also **Ctrl + Click** the plugin, and then select **Move to Trash**.

You can restore it by dragging it out of the Trash, or you can **Ctrl + Click** the plugin from the Trash, and select **Put Back**.

Once you remove the plugin from your Internet Plug-ins, it is removed from your Mac and from all other browsers on your computer. Please note that each time you launch GoToMeeting, the plugin will automatically become re-enabled.

**Disable the Citrix Online Launcher plugin in Firefox on Macs**

1. Open Firefox.
2. Select the **Tools menu > Add-ons**.
3. In the Add-ons Manager, find the **Citrix Online Web Deployment Plugin**. Click **Disable**.

You can re-enable it by clicking **Enable**. Please note that each time you launch GoToWebinar, the add-on will automatically become re-enabled.
Disable the Citrix Online Launcher plugin in Chrome on Macs

1. Open Google Chrome, and type chrome://plugins/ into the address bar.
2. Find the Citrix Online Web Deployment Plugin, and click Disable.

You can re-enable it again by clicking Enable. Please note that each time you launch GoToWebinar, the plugin will automatically become re-enabled.
Download the Launcher File on Mac

The first time you host/join a session or upgrade/downgrade GoToWebinar on a Mac, you'll be prompted to download a file with an optional browser plugin that lets you launch the GoToWebinar software faster. If you uninstall GoToWebinar, you'll need to go through the download process again.

Download the Citrix Online Launcher file in Safari

1. Launch GoToWebinar by hosting or joining a session.

2. A file called “Citrix Online Launcher” will start downloading to your computer. Double-click the file in your browser’s Downloads window to open it. You can click restart the download if needed.

3. If the file doesn't open automatically, double-click the Citrix Online Launcher file in your Downloads folder in Finder.

4. When prompted to open “Citrix Online Launcher”, click Open.
The browser plugin will be automatically installed and lets you connect to future sessions faster. We don’t recommend disabling the plugin if you frequently join sessions because you’ll need to go through the entire download process again.

5. When prompted to open GoToWebinar, click Open.

6. Once you’re done, you’ll be able to host and join future GoToMeeting, GoToWebinar and GoToTraining sessions faster than ever!

**Download the Citrix Online Launcher file in Firefox**

1. Launch GoToWebinar by hosting or joining a session.

   **Note:** If you already have GoToWebinar installed, you may see a Launch Application dialog to launch either GoToWebinar or Citrix Online Launcher. Select the “Remember my choice” check box and then click Launch Application.

   If you see the dialog to launch Citrix Online Launcher, you’ll briefly see another dialog that shows the downloading progress.
If you click **Cancel**, you must click **Download** GoToWebinar on the Connected to GoToWebinar page and go through the download process below.

2. A file called “Citrix Online Launcher.zip” will start downloading to your computer. If prompted to save the Citrix Online Launcher.zip file, click **Save File**.
3. Double-click the zip file in your browser’s Downloads window to open it. You can click restart the download if needed.

4. In the Downloads window, double-click the Citrix Online Launcher.zip.

5. When your Downloads folder opens in Finder, double-click the Citrix Online Launcher application.

6. When prompted to open “Citrix Online Launcher”, click Open.

The browser plugin will be automatically installed and lets you connect to future sessions faster. We don’t recommend disabling the plugin if you frequently join sessions because you’ll need to go through the entire download process again.
7. When prompted to open GoToWebinar, click **Open**.

8. Once you’re done, you’ll be able to host and join future GoToMeeting, GoToWebinar and GoToTraining sessions faster than ever!

**Download the Citrix Online Launcher file in Chrome**

1. Launch GoToWebinar by hosting or joining a session.

   **Note:** If you already have GoToWebinar installed, you may see an External Protocol Request dialog to launch either GoToWebinar or Citrix Online Launcher. Select the “Remember my choice” check box and then click **Launch Application**.

   If you see the dialog to launch Citrix Online Launcher, you’ll briefly see another dialog that shows the downloading progress.

   If you click **Do Nothing**, you must click **Download** GoToWebinar on the Connected to GoToWebinar page and go through the download process below.
2. A file called “Citrix Online Launcher.zip” will start downloading to your computer. Double-click the zip file to open it. You can click **restart the download** if needed.
3. In the Downloads folder, double-click the Citrix Online Launcher.zip.

4. When prompted to open “Citrix Online Launcher”, click Open.

The browser plugin will be automatically installed and lets you connect to future sessions faster. We don’t recommend disabling the plugin if you frequently join sessions because you’ll need to go through the entire download process again.

5. Once you’re done, you’ll be able to host and join future GoToMeeting, GoToWebinar and GoToTraining sessions faster than ever!
Download the Launcher File on Windows

The first time you host/join a session or upgrade/downgrade GoToWebinar on a Windows computer, you’ll be prompted to download a file with an optional browser plugin that lets you launch the GoToWebinar software faster. If you uninstall GoToWebinar, you’ll need to go through the download process again.

Download the Citrix Online Launcher file in Internet Explorer

Note: If GoToMeeting is already installed, Internet Explorer 9 may redirect you to the Connected to GoToWebinar page without launching the GoToWebinar application. Please install Internet Explorer 9.0.3 or above to successfully launch GoToWebinar using Internet Explorer 9 and refer to this Windows support article for further troubleshooting information.

1. Launch GoToWebinar by hosting or joining a session.

   Note: If you’re using Internet Explorer 8 and already have GoToWebinar installed, click No when you see the Security Warning dialog to immediately launch into session.

If you click Yes, you must click Download GoToWebinar on the Connected to GoToWebinar page and go through the download process below.
2. A file called “Citrix Online Launcher.exe” will start downloading to your computer. Double-click the file to open it. You can click **restart the download** if needed.

3. When prompted to open “Citrix Online Launcher”, click **Run**.

4. If you're prompted again to run "Citrix Online Launcher", click **Run**.
The browser plugin will be automatically installed and lets you connect to future sessions faster.

4. Once you’re done, you’ll be able to host and join future GoToWebinar sessions faster than ever!

**Download the Citrix Online Launcher file in Firefox**

1. Launch GoToWebinar by hosting or joining a session.

   **Note**: If you already have GoToWebinar installed, you may see a Launch Application dialog to launch either GoToWebinar or Citrix Online Launcher. Select the “Remember my choice” check box and then click **Launch Application**.

If you see the dialog to launch Citrix Online Launcher, you'll briefly see another dialog that shows the downloading progress.
If you click **Cancel**, you must click **Download GoToWebinar** on the Connected to GoToWebinar page and go through the download process below.

2. A file called “Citrix Online Launcher.exe” will start downloading to your computer. If prompted to save the Citrix Online Launcher.exe file, click **Save File**.
3. Double-click the file in your browser’s Downloads window to open it. You can click **restart the download** if needed.

4. When prompted to open “Citrix Online Launcher”, click **Run**.
The browser plugin will be automatically installed and lets you connect to future sessions faster. We don’t recommend disabling the plugin if you frequently join sessions because you’ll need to go through the entire download process again.

5. Once you’re done, you’ll be able to host and join future GoToWebinar sessions faster than ever!

**Download the Citrix Online Launcher file in Chrome**

1. Launch GoToWebinar by hosting or joining a session.

   **Note:** If you already have GoToWebinar installed, you may see an External Protocol Request dialog to launch either GoToWebinar or Citrix Online Launcher. Select the “Remember my choice” check box and then click **Launch Application**.

   ![External Protocol Request](image1)

   ![External Protocol Request](image2)

   If you see the dialog to launch Citrix Online Launcher, you’ll briefly see another dialog that shows the downloading progress.
If you click **Do Nothing**, you must click **Download GoToWebinar** on the Connected to GoToWebinar page and go through the download process below.

2. A file called “Citrix Online Launcher.exe” will start downloading to your computer. Double-click the file to open it. You can click **restart the download** if needed.
3. When prompted to open “Citrix Online Launcher”, click **Run**.

The browser plugin will be automatically installed and lets you connect to future sessions faster. We don't recommend disabling the plugin if you frequently join sessions because you'll need to go through the entire download process again.

4. Once you're done, you'll be able to host and join future GoToWebinar sessions faster than ever!
Join Help

If you are experiencing difficulty joining a session, determine which scenario is applicable to you and follow the recommended guidelines.

I can’t join a session.

If you’re having trouble joining a session, learn about downloading the installer on Windows and Mac. We highly recommend leaving the optional browser plug-in enabled so that you can join sessions faster without having to go through the download process again.

I'm using Internet Explorer 7 or 8 and nothing is happening.

If you're using Internet Explorer 7 or 8 and already have GoToWebinar installed, click No when you see the Security Warning dialog to immediately launch into session.

If you click Yes, you must click Download Webinar on the Connected to Webinar page and go through the download process below.
I'm using Internet Explorer 9 and nothing is happening.

If GoToMeeting is already installed, Internet Explorer 9 may redirect you to the Connected to GoToWebinar page without launching the GoToWebinar application. Please install Internet Explorer 9.0.3 or above to successfully launch GoToWebinar using Internet Explorer 9 and refer to this Windows support article for further troubleshooting information.

I'm using Firefox on Windows and nothing is happening.

If you already have GoToWebinar installed and see a Launch Application dialog, select the "Remember my choice" check box and then click OK.

If you click Cancel, you must click Download GoToWebinar on the Connected to GoToWebinar page and go through the download process below.
I'm using Chrome on Windows and nothing is happening.

If you already have GoToWebinar installed and see an External Protocol Request dialog, select the "Remember my choice" check box and then click **Launch Application**.

If you click **Do Nothing**, you must click **Download GoToWebinar** on the Connected to GoToWebinar page and go through the download process below.
I'm using Firefox on Mac and nothing is happening.

If you already have GoToWebinar installed and see a Launch Application dialog, select the "Remember my choice" check box and then click OK.

If you click Cancel, you must click Download GoToWebinar on the Connected to GoToWebinar page and go through the download process below.
I'm using Chrome on Mac and nothing is happening.

If you already have GoToWebinar installed and see an External Protocol Request dialog, select the "Remember my choice" check box and then click Launch Application.
If you click **Do Nothing**, you must click **Download GoToWebinar** on the Connected to Webinar page and go through the download process below.

I can't use GoToWebinar with a firewall, anti-virus program or anti-spyware.

If you have a program or firewall (such as Norton or McAfee) on your Windows computer that blocks connection with applications, you may need to manually enable GoToWebinar to join sessions.

**Configure firewalls on your computer**

1. Host or join a session to set off your firewall.

2. When prompted to enable GoToWebinar to access the Internet, click **Yes**. Then select the "Remember the answer each time I use this program" check box.

3. Open your anti-virus program to allow it to accept all GoToWebinar files. The following must be admitted via 1 of 3 ports: 80, 443 or 8200. One-way TCP connectivity is required (TCP outbound).

<table>
<thead>
<tr>
<th>g2m_download.exe</th>
<th>G2MStart.exe</th>
<th>G2MChat.exe</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppCore.exe</td>
<td>G2MLauncher.exe</td>
<td>G2MQandA.exe</td>
</tr>
<tr>
<td>G2MInstallerExtractor.exe</td>
<td>G2MTesting.exe</td>
<td>G2MSessionControl.exe</td>
</tr>
<tr>
<td>G2MCodeInstExtractor.exe</td>
<td>G2MPolling.exe</td>
<td>G2MRecorder.exe</td>
</tr>
<tr>
<td>G2MInstHigh.exe</td>
<td>G2MView.exe</td>
<td>G2MTranscoder.exe</td>
</tr>
<tr>
<td>G2MInstaller.exe</td>
<td>G2MUI.exe</td>
<td>G2MFeedback.exe</td>
</tr>
<tr>
<td>G2MUninstall.exe</td>
<td>G2MComm.exe</td>
<td>G2MHost.exe</td>
</tr>
</tbody>
</table>
Configure firewalls within a corporate environment

If you’re using a firewall in a corporate environment, you may have a hardware firewall. Instruct your IT department to read the Optimal Firewall Configuration Fact Sheet to allow GoToWebinar to connect.

Set up Norton® Anti-virus Software to allow GoToWebinar

1. In your system tray, right-click the Norton Internet Security icon.
3. From the Status & Settings menu, select Personal Firewall > Configure.
4. Select the Programs tab to locate GoToWebinar, and then click Add.
5. To begin adding files, select g2mcomm.exe > Open.
6. When prompted, use the drop-down menu to select Permit > OK. Then repeat the steps for the remaining GoToWebinar files.

Set up Norton® Transaction Protection to allow GoToWebinar

If your version of Norton Internet Security has the Norton Transaction Protection feature enabled, you may need to adjust your Norton settings before you can use GoToWebinar.

1. If you haven't already done so, start and then end a GoToWebinar session.
2. Right-click the Norton Internet Security icon while it's visible in your system tray.
4. Select the Norton Internet Security tab at the top of the window.
5. From the Settings drop-down menu, select Norton Internet Security Options > Transaction Protection.
6. Change the status to allow "g2mlauncher.exe," and then click OK.

Set up ZoneAlarm Firewall to allow GoToWebinar

1. In your system tray, double-click the ZoneAlarm icon.
2. Select Program Control > Programs tab > Add.
3. On your computer, navigate to C:\Program Files\Citrix\GoToMeeting. Select all the GoToMeeting files, and click Open.
4. Locate the GoToMeeting file in the Programs list. In the Trust Level column, click the Question Mark icon, and select Super. Repeat this step for each of the GoToMeeting files.
5. Finally, in the Access and Server columns, click each Question Mark icon that corresponds to a GoToMeeting program, and select Allow.

McAfee® Total Protection Anti-virus Software to allow GoToWebinar

1. In your system tray, right-click the McAfee Total Protection icon.
2. Select Open McAfee Total Protection.
3. Then click Firewall > Settings.
4. In the Program Permissions, scroll down and select GoToMeeting > Edit.
5. Using the Access drop-down menu, select Full. Then click Save.

**Set up Kaspersky® Anti-virus Software to allow GoToWebinar**

1. Open Kaspersky Anti-Virus 2010, and click Settings.

3. Under the Options in the left navigation, select Threats and exclusions. Then select Settings in the Exclusions section.

4. Select the Trusted Applications tab > Add.

6. Browse to the GoToMeeting program folder, and select all of the check boxes for exclusions. Click OK twice, and then click Apply.

[Download the Launcher File on Windows](#)
Test Your Connection before Your Session

You can test your connection before your session starts by joining a test session to check that your computer has everything required.

Join the test session

1. To test your connection, join the test session via https://www3.gotomeeting.com/join/406552062.

2. If you're on a desktop, you may need to download the Citrix Online Launcher file for Windows or Mac to launch GoToWebinar.

3. If you see a "Successfully Connected" message on the "Waiting for Organizer" dialog, you've successfully joined the test session. You should be able to join GoToMeeting, GoToWebinar and GoToTraining sessions from this computer. Close the "Waiting for Organizer" dialog to exit the test session.

To test or troubleshoot issues with your audio or webcam, contact us by phone 24/7.

If you're unable to join the session, you may not have all the necessary software. See Join Help for more troubleshooting tips, and make sure you have all the System Requirements.